Fast Track to Digital Photography

Digital Vs Conventional
Low-light Photography
Give Old Images A Makeover
Adding Special Effects
Photo Imaging And Editing
Sharing Your Photos
Camera phone Photography

YOUR HANDY GUIDE TO EVERYDAY TECHNOLOGY
Fast Track
To
Digital Photography
Credits
The People Who Made This Book Possible

EDITORIAL
Aditya Kuber Editor
Gagan Gupta Writer
Robert Sovereign-Smith Copy Editor
Ram Mohan Rao Copy Editor
Renuka Rane Copy Editor
Meera Vankipuram Writer

DESIGN AND LAYOUT
Jayan K Narayanan Lead Designer
Harsho Mohan Chatteraj Illustrator
Vijay Padaya Layout Artist
Sivalal S Layout Artist
Atul Deshmukh Design Support
Mexy Xavier Photographer
Jiten Gandhi Photographer
Shyam Shriram Design Support
Rohini Dalvi Coordinator

© Jasubhai Digital Media
Published by Maulik Jasubhai on behalf of Jasubhai Digital Media. No part of this book may be reproduced, stored in a retrieval system, or transmitted, in any form or by any means without the prior written permission of the publisher.

March 2005
Free with Digit. Not be sold separately. If you have paid separately for this book, please send a mail to editor@thinkdigit.com along with details of location of purchase for appropriate action.
WHEN WE FIRST decided to publish a book with every issue of Digit, and then later decided that the first book would be on digital photography, I must admit I was a bit apprehensive. A 200-page on digital photography? Would readers love it? Would we be able to give great content that will justify this effort?

But when I finally saw the book, I knew we are onto a big thing. Coming out with a book this in-depth not only takes superhuman effort, it also means every single person from the team contributing to this Herculean task. Books normally take months to publish; Digit managed it in three weeks, the exact time we get to publish a magazine, put all the great software on to the DVD and on the CD.

This book works at different levels-for the novice to the intermediate user to the expert. As a professional photographer, took me back to the days while I was still grappling with the fundamentals of photography.

This book is not just about the technology behind digital cameras, it is also equally about photography. Interestingly, for the reader, the structure of the book is like an opera. It begins at the basics, then gradually takes the reader to successive steps to understanding digital cameras and photography, reaching a crescendo with all the wonderful things you could ever do with a digital camera.

Admittedly, this book won’t make a great photographer of anyone-that would ultimately depend on how dedicated a person is towards the craft. However, Fast Track to Digital Photography will create a whole new generation of users, who would be able to utilise this knowledge to attempt better pictures than before. They would also be able to share better, edit better, print better.

I hope you love the first issue of Fast Track.

Mexy Xavier
Photographer, Digit
The Future Of Photography Is Here

Digital photography is here to stay. In its early days, purists questioned whether this was the real thing and were even ready to write it off. But relentless development and evolution has meant that digital cameras have become household gadgets that everyone feels is a must-have.

Digital cameras and photography did come at a price, though. While they cut down on recurring costs, they also necessitated the presence of a computer at your premise adding to the investment. But the argument that almost every home would anyways have a computer has helped speed up the popularity of these gadgets.

Digital cameras have gone through their evolution cycle and have had their technological ups and downs. The industry has now more or less settled on the base technology and the entry-level specifications. While this process has taken a good decade, it has still been much faster that the two centuries it took for conventional photography to reach a benchmark.

Digital photography brings with it various advantages and disadvantages. The advantages are in the form of speed, quality and ease of use while the disadvantages are in the form of lack of reliability and high initial investment. But these disadvantages are slowly being relegated to the ‘perceived’ category rather than the actual ones. It is therefore natural that almost all of us would like to make use of the advantages.

Which brings us to this book... Thanks to our readers who belong to different backgrounds and strata of society, we have our pulse on what it is they have and what it is they want. It is an interesting fact therefore, that a large number of Indians own a digital camera but not too many are aware of its capabilities or the possibilities that digital imaging offers.

Through this book, we aim to dispel many a myth that has kept a lot of digital camera owners away from exploiting the true potential of their cameras and educate those who did not know
where to go for the most basic of information regarding digital photography and its possibilities.

You will find most of the information you wanted to have about digital photography and some important (though seemingly innocuous) tips and hints throughout the book.

While the book has been confined to address the beginners, there is much more to digital photography. Basic information about understanding your camera, the accessories with it, transferring photos, basic editing and organising and sharing your photos has been dealt with extensively in the book.

But digital photography is more than just shooting or transferring. Digital imaging encompasses image manipulation and is fast being recognised as a new age means of expression. At the end of the day, it’s the same as with any art form—what you can do is limited only by your dedication or your imagination.

So there is also a section on ‘Tools’ that gives you the information on some of the best software there is and the better Web sites for learning, and a host of books that can enhance your knowledge and fuel your passion for photography further.

Thanks to digital photography, the time may have come that the average Indian could document his whole life and not just few events. We hope this book gives you the inspiration to do so and sets you off on a quest to capture all things beautiful.

Happy Shooting.
# Contents

## Part 1  Getting Started and Shooting

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.1</td>
<td>Why digital photography? Yes, why? Find out.</td>
<td>18</td>
</tr>
<tr>
<td>1.2</td>
<td>Digital versus conventional photography Is digital photography really better?</td>
<td>19</td>
</tr>
<tr>
<td>1.3</td>
<td>Selecting a digital camera Which digital camera is right for you?</td>
<td>26</td>
</tr>
<tr>
<td>1.4</td>
<td>Know your camera What all does your camera have?</td>
<td>30</td>
</tr>
<tr>
<td>1.5</td>
<td>Setting up your digital camera What additions should you invest in?</td>
<td>35</td>
</tr>
<tr>
<td>1.6</td>
<td>Accessories for your digital camera Don’t just aim-and-shoot. Know what you are doing</td>
<td>37</td>
</tr>
<tr>
<td>1.7</td>
<td>Basics of composition/photography Things to watch out for and some DOs and DONTs</td>
<td>39</td>
</tr>
<tr>
<td>1.8</td>
<td>Viewing and transferring images It’s time to get those images on your computer</td>
<td>42</td>
</tr>
</tbody>
</table>

## Part 2  Editing and Enhancing Your Digital Photos

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.1</td>
<td>Introduction to Photoshop The basics of Photoshop explained</td>
<td>44</td>
</tr>
<tr>
<td>2.2</td>
<td>Manipulating Image Attributes Making basic changes to your images</td>
<td>48</td>
</tr>
<tr>
<td>2.3</td>
<td>Fixing Common Image Problems Freeing your image of the basic problems</td>
<td>54</td>
</tr>
<tr>
<td>2.4</td>
<td>Fun and Games More than just cleaning and adjusting—get creative</td>
<td>60</td>
</tr>
</tbody>
</table>
### Part 3  Sharing and Organising your digital photos  Page No.

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.1</td>
<td>Organise your digital photos</td>
<td>64</td>
</tr>
<tr>
<td></td>
<td>Specialised software that make organising piles of photographs a breeze</td>
<td></td>
</tr>
<tr>
<td>3.2</td>
<td>Printing your digital photos</td>
<td>69</td>
</tr>
<tr>
<td></td>
<td>The good old-fashioned way of sharing your photos</td>
<td></td>
</tr>
<tr>
<td>3.3</td>
<td>Sharing your photos online</td>
<td>71</td>
</tr>
<tr>
<td></td>
<td>Create a website or upload to an online album</td>
<td></td>
</tr>
</tbody>
</table>

### Part 4  Special Projects  Page No.

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.1</td>
<td>Shooting for the Internet</td>
<td>76</td>
</tr>
<tr>
<td></td>
<td>There are ways you can save time and effort by shooting specially for the Internet</td>
<td></td>
</tr>
<tr>
<td>4.2</td>
<td>Shooting your travels</td>
<td>78</td>
</tr>
<tr>
<td></td>
<td>Do more than just document your adventures</td>
<td></td>
</tr>
<tr>
<td>4.3</td>
<td>Restoring photographs</td>
<td>80</td>
</tr>
<tr>
<td></td>
<td>Have some old photos that have been worn down by time? Now you can bring them back to life</td>
<td></td>
</tr>
<tr>
<td>4.4</td>
<td>Your autobiography in photos</td>
<td>82</td>
</tr>
<tr>
<td></td>
<td>Create a photographic story of your life</td>
<td></td>
</tr>
<tr>
<td>4.5</td>
<td>Low-light photography</td>
<td>83</td>
</tr>
<tr>
<td></td>
<td>Nighttime does not mean you pack up your camera and call it a day... the night presents great opportunities for the roving eye</td>
<td></td>
</tr>
<tr>
<td>4.6</td>
<td>Shooting children</td>
<td>87</td>
</tr>
<tr>
<td></td>
<td>The apple of your eye... the light of your life... make him the star of your photos</td>
<td></td>
</tr>
<tr>
<td>4.7</td>
<td>Nature Photography</td>
<td>90</td>
</tr>
<tr>
<td></td>
<td>The great outdoors beckon... do you have it in you to rough it?</td>
<td></td>
</tr>
</tbody>
</table>
### Part 5  Tips and Tricks

A collection of a wide range of tips and tricks to help you enhance your photographic skills. Some of the featured tips include:
- Recovering lost photos
- Scanning old photos and digitising them
- Shooting fireworks
- Using flash modes
- Creating slideshows and screensavers
- Shooting Silhouettes
- Caring for your camera and accessories

<table>
<thead>
<tr>
<th>Books</th>
<th>Page No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>A wide range of reading material collected just for you. These books deal with a variety of topics—some in-depth, some for beginners and some just for fun</td>
<td>120</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Software</th>
<th>Page No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Over 20 pages of the best software for imaging. Everything from organising software to ones that create calendars, slideshows, and presentations to even the top-of-the-line photo editing software</td>
<td>00</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Websites</th>
<th>Page No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Internet is an endless pool of resource and we dip into it to bring you some of the best from this pool. From sites that present reviews to those offering courses, our list has it all</td>
<td>00</td>
</tr>
</tbody>
</table>

### Part 6  Tools

<table>
<thead>
<tr>
<th>Chapter 6.1  Books</th>
</tr>
</thead>
<tbody>
<tr>
<td>A wide range of reading material collected just for you. These books deal with a variety of topics—some in-depth, some for beginners and some just for fun</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 6.2  Software</th>
</tr>
</thead>
<tbody>
<tr>
<td>Over 20 pages of the best software for imaging. Everything from organising software to ones that create calendars, slideshows, and presentations to even the top-of-the-line photo editing software</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 6.3  Websites</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Internet is an endless pool of resource and we dip into it to bring you some of the best from this pool. From sites that present reviews to those offering courses, our list has it all</td>
</tr>
</tbody>
</table>

### Part 7  Glossary

You no longer need to ask “What does that mean?” Presenting the jargon buster that clears any doubts you ever had
Photography is an art and a science. There are techniques, rules, and even laws. But most of all, it's something we have all come to embrace as an integral part of our lives.

As photography goes digital, it's time you knew how to make the most of it. Part 1 of this book deals with the basics of photography and everything you ever wanted to know about what to do and what not to do when taking photos.
1.1 Why Digital Photography?

It has been more than a century since photography made its appearance. Since its birth, photography as an art and as a science has fascinated anyone who came in touch with it. Today, photography forms the single-most important aspect of our lives. The power of photographs is so enormous that they last far more than your memories and we cannot imagine any event—no matter how big or small—without our cameras.

Naturally, as has been the case with almost all things in our lives, technology has improved the way photography is done and the way we share our memories. Digital photography, in its 10 years of existence, has increased the speed at which we capture, share and cherish the important moments of our life.

While digital cameras have virtually replaced film cameras, there are doubts and questions even owners of digital cameras have about the possibilities of using their trusted lightboxes! This book aims at setting you on the path to discovering photography and its countless opportunities. As with the light of the day, only your imagination can limit your photography.
1.2 Digital Versus Conventional Photography

The advantages digital photography offers over conventional (or analogue photography as it is sometimes called), range from the obvious to the obscure. Here are a few clear advantages of using a digital camera.

**No Recurring Costs**

Thanks to the presence of an LCD screen, you can view your photos immediately and decide whether you like them and if you want to keep them or re-shoot. So there’s no uncertain waiting and no chance of any photo lab messing up the photos.

Moreover, when it comes to printing the photos, you don’t have to print all of them. You can choose the good ones and print only those meaning you don’t pay for the bad ones. Chances are, though, that you’ll print all since the bad ones were deleted anyways! But the value for money remains high!

Also, imagine the time and energy saved when printing digital photos. There are ways of ordering digital prints online or just printing them at home. (More on this later in the book.)

**BUYING TIP**

When deciding on buying a digital camera, you should pre-decide some parameters. Choose your priorities: cost, final use of images, additional features, service, availability of accessories and finally, the manufacturer (unless you are loyal or brand conscious!). These parameters should be enough to guide you through your buying decision.
Although you might feel that you are spending too much on a digital camera, the amount of money you would save in the long run is definitely worth it.

**Room For Experimenting**

Digital cameras are a liberating tool. They allow you more room for experimentation. Even when you have nothing to do, you could simply pick up your digital camera and shoot away! Later, just delete them. No costs.

Such dynamism allows you to perfect your photographic skills so you don’t go wrong again when you are taking the real shot. Think of it as rehearsing for the final take!

**Functionality In A Small Package**

While it’s a fact that SLRs (digital or conventional) generally offer better results than any compact camera, and while a digital camera is not a substitute for this, it can be a handy replacement if you really don’t need a large, bulky SLR with numerous lenses, flashes, tripods and bag of its own!
Today’s digital cameras are equipped enough to offer you the quality and creativity options that SLRs of yore offered. While SLRs themselves have evolved, digital cameras, having been the centre of attention over the last few years, have evolved faster than expected. The question when developing most new digital cameras is—how it can be made more SLR-like.

Digital cameras are smaller, normally offer an ISO range of 100-400 in three steps (100, 200 and 400) and the lenses range from 35mm to 120mm and are reasonably fast (f/4). Consequently, this allows for quality photos in daylight and indoors (using the built-in flash) and acceptable photos in low-light conditions. Digital cameras also offer certain special functions such as Macro, Long Exposures, Fill-flash and some models also sync with external flash units. And no, you do not need to go buy attachments to do all this! These functions are built-in.

**LCD Eliminates Guesswork**

One of the most important additions to a camera has been the LCD screen. It simply removes the guesswork from photography—including composition, exposure, zoom—so much so, that you need not know the terms we just mentioned! Interestingly, having an LCD screen on your camera can also have another application—a portable photo album. How?
Just load the photos you want to share with friends on to your memory card and you’re all set!

**Durability**

This is an arguable point, but it’s well known that various factors like dust, heat and moisture can destroy photographs with time. Digital pictures burnt on a good quality CD will stay well protected for much longer.

---

This is normally what happens when your cherished photographs collect dust. If you think you can make another print, all the best. By the way, where’s the negative?

---

**TIP**

Even old prints can stand the test of time if they are stored properly. Avoid using plastic sleeves to store your photos. Use paper backgrounds as these are better when the climate changes every few months! You should also store your photos in a dry place and away from humidity—the worst enemy of prints. Even then, if your prints go bad, there are ways of restoring them digitally.
**Scalability**
You can use digital pictures in a lot more applications than just a photo album. You can make them into backgrounds for your computer desktop or even your cell phone. You can also use digital photos in a catalogue for your store or in a business presentation. The options are limited only by your imagination.

**Sharing**
The most highly-used feature of digital images is that they can be easily shared with your friends or relatives. Instead of going through the process of getting your negatives re-developed, you can simply e-mail your digital image to anyone who wants a copy.

**Achieve Perfection**
If there’s something missing in your picture, you can add it digitally on your home computer. Fix red eyes, correct the colours and just about do anything you want with it. Since you have the freedom to view your images before printing them, there is absolutely no holding back on the aspects you can manipulate in those images before printing them.

On the flip side, we’d be lying if we said that film photography didn’t have a few compelling advantages over its digital counterpart. Here’s looking at a few.

**Battery Life**
With film cameras, batteries are the least of your worries. Two standard alkaline AA batteries will last you for multiple rolls. Since everything inside a film camera is mainly mechanical, the battery’s main purpose is powering the flash. Digital cameras, on the other hand, can suck the battery dry in less than an hour if you’re not careful, since it’s completely com-
puterised. Keep the LCD on and take all your pictures with flash and watch the battery meter go down faster than you can say ‘Recharge!’

Limited Memory
We mentioned earlier that you can always make extra space for a picture by deleting some not-so-great images from your memory card, however, the fact remains, you will feel the space crunch at some time. When you have a memory card full of great shots, you’ll have no choice but to pack that camera and call it a day. That’s why you’ll always find professional digital photographers lugging a laptop with them at all times.

Learning Curve
Not everyone knows or realises the optimum use of digital images. Many users suffer from a level of technophobia that prevents them from fixing some basic defects in their picture. The bundled software usually does have a level of learning curve before a user can utilise it to its fullest.

INFO
Digital photography has a great advantage of costing nothing for repetitive shots. Same is the case when you are working with a software. Just apply every effect, filter or mode you can find. How does it hurt? Just remember to keep a copy of the original safely so you know where you started! In case you forget, just go to the ‘History’ palette and click on the ‘File Open’ line at the top.
But like with anything else, the best way to get a hang of whatever software you are using is to experiment and practice. Without trying out various things, you will never know what capabilities your software has.

Another positive rub-off this can have, is that it could give you some ideas when you are shooting. Think of it as an editor who is shooting... he knows what the possibilities of effects and presentation are and shoots accordingly.

Finally, give yourself time. If you are new to photography, it can be frustrating to see a plethora of fabulous images but not shoot or create those. Over time, your photography will improve and eventually, you could also shoot the same quality. All you have to be is relentless in your pursuit of quality.
1.3 Selecting a Digital Camera

There are various factors that come to mind when buying a digital camera. When you’re investing thousands of rupees for a camera, you want to make sure you don’t buy a model that doesn’t really suit your purpose or is much too advanced for your requirements. We have listed a few pointers that may assist you in making the right buying decision.

CCD Or CMOS?

CCD and CMOS are the two types of image sensors used in digital cameras. Cameras with CCD sensors are recommended over CMOS plainly because the image quality is tremendously better in the former. Though CMOS lenses are significantly cheaper to manufacture and easier to implement than CCDs, the difference in image quality is simply passable.

CMOS sensors are extremely portable and require considerably lesser battery power—precisely why their most common application is in webcams and phone cams. All examples in this book are based on consumer cameras and are hence referring to CCD-sensor cameras unless otherwise mentioned.

The Price Factor

The price for a decent 3-megapixel digital camera can start at around Rs 6,500 and can go to well and above Rs 50,000 for a 7-plus megapixel model. Features vary from one model to another. While some low-end cameras offer complete manual control for amateur photographers who wish to experiment, some stick to the strict point-and-click norm.
If you belong to the latter category, the lowest end model will be more than enough for your needs, but if you take photography seriously and would prefer to have options to tweak every setting that affects your image, you may want to shell out a bit more for that slightly better ‘prosumer’ camera.

The Megapixel Myth

First things first—higher megapixel count is in no way a measure of the quality of your pictures. Quality is determined by the image sensor; megapixel count simply denotes how big your image would be. For any home user who wants to post snapshots on the Internet or print them on a maximum of an A4 size photo paper does not need anything more than a 3-megapixel camera.

Though the megapixel count does not directly relate to image quality, it is noticed that the higher megapixel cameras have more professional features, hence they are generally more expensive.

Amateur photographers and prosumers may want to invest in a 4-5 megapixel camera for some of its advanced options. We have listed a guideline as to what megapixel count would be suitable for a particular sized print. You can choose your type of camera based on the size of your prints.

Ready Reckoner: Mega-pixel count vis-à-vis Print size

<table>
<thead>
<tr>
<th>Megapixel</th>
<th>Print Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>3MP</td>
<td>5 x 7 inches to 8 x 10 inches</td>
</tr>
<tr>
<td>4MP</td>
<td>8 x 10 inches to 8.5 x 11 inches</td>
</tr>
<tr>
<td>5MP</td>
<td>8.5 x 11 inches to 9 x 12 inches</td>
</tr>
<tr>
<td>6MP</td>
<td>9 x 12 inches to 11 x 14 inches</td>
</tr>
<tr>
<td>8MP</td>
<td>14 x 17 inches to 16 x 20 inches</td>
</tr>
</tbody>
</table>
Features You May Require
When you buy a digital camera, there are some additional features you may want to examine. As mentioned earlier, manual override function may be appreciated by advanced users as they can enjoy complete control of what they are shooting.

Besides that just keep your eyes open for basic features such as the kind of flash options, red eye flash, self timer, Black and White/Sepia modes and the optical zoom level.

Most digital cameras have some video shooting capability. Don’t forget to check whether the digital camera you are buying records video with or without sound.

Bundled Goodies
Digital cameras usually come with little or no onboard memory. Even if the manufacturer does put some onboard memory, it won’t exceed 8-16 megabytes, which won’t last you too long. That’s why it’s important you consider a seller who bundles a memory card along with the camera.

WATCH OUT
Grey market cameras are cheaper by about 25 per cent as compared to those sold officially. But the catch is that cameras purchased from the grey market carry no warranty and the shop that sold you the camera is not liable for any defects it may have. It’s as good as gambling the money you are spending on your camera. Watch out.
Also, make sure that along with drivers for your computer, there’s some bundled software included for sorting, cataloguing and minor image manipulations.

The good news is you won’t have to worry too much about this part because the abovementioned bundle has become an industry standard. However, it’s a good idea to keep your eyes open for additional accessories you may want to purchase for your camera.

**Durability And Warranty**

When it comes to electronics, bad things always happen when you least expect them to. It is a good idea to be prepared for the worst.

This means even having to pay a little more when you purchase your camera.

Almost all officially purchased cameras are accompanied by a one-year warranty that covers manufacturing defects. Moreover, most warranties are valid worldwide (although, it would be a good idea to check this for every individual purchase) and this adds to the safety and value. What we are trying to emphasise here, is that spending an extra Rs 2,000 to Rs 5,000 is better than purchasing from the grey market. At least there is someone who would take responsibility for things gone wrong!

**WATCH OUT**

Camera manufacturers are not averse to publicising the zoom with a particular camera as “30X”. But in most cases, it means 10X Optical multiplied by 3X digital effectively leaving you with 10X zoom that is practically usable. Watch out for this when deciding on a camera to buy. Optical zoom is definitely preferred over digital zoom.
1.4 Know your Camera

Little do most casual users know about the features they have at their disposal when they purchase a digital camera. In this section, we’ll provide you with information about various aspects of your digital camera that you need to know to take that perfect shot.

**Zoom**

Zoom lens is a must on any digital camera as they help capture more on the subject that will be the main focus of your snapshot. As the name suggests, with a zoom lens you can take a closer shot of the subject without ever physically moving closer.

**INFO**

Flash can be as useful a tool as it can be irritating. When used correctly, flash is the ideal aide for quality photographs. But remember, that’s all it is... an aide. Don’t be shy to experiment with flash modes available in your camera. It can also be a good creative tool. Modes like Rear Sync, Bounce and Fill flash have more applications than just illuminating the subject!

Most digital cameras these days sport a zoom function, which may be anything from 3X to even 24X, but usually that number is divided into optical zoom and digital zoom. In actual functionality, it’s only the optical zoom level that matters since that’s what relates to the physical capacity of the lens. Digital zoom only enlarges a selected part of the image giving you a simulation of a zoom,
while in reality it’s only stretching the picture causing a loss in image quality. It’s best to turn off the digital zoom function in your camera if you’re stringent about the quality of your photos. Optical zoom can be anything from 3X to even 12X.

**Flash**

Many casual photographers fail to see the relevance of the flash function besides ‘making faces visible in the dark’. If you happen to be one of them, then pay attention, there’s a lot you can do with your integrated flash. For starters, some digital cameras allow you to change the intensity level of the flash to plus (for higher flash output) or minus (lower flash output) depending on your requirement. For optimum effects in low light, its best to move the subject as close to a natural source of light like a window with sunlight falling through. Its also recommended to turn on all the lights in the room so that the background is not left completely dark.

Flash can also be used in daylight photography. For example, if the subject is standing right in front of the sun, you can use fill-flash to illuminate the subject so it doesn’t come blacked out. You can also use fill-flash to eliminate dark, shadowy areas that lack detail.
Exposure
As the term ‘photography’ suggests, light is the soul of your photograph. But be it digital or film photography, with too much light the picture will appear washed out and with too little light the picture appears dark and muddy. Exposure is the measure of the amount of light used to create a photo, and that’s exactly what makes a good photograph.

Most digital cameras use auto exposure to set the appropriate level of light required for a shot. All you need to do is press the shutter button half way down and let the camera take a few seconds to adjust the aperture and shutter speed. However, it is not always recommended to shoot on the recommended exposure levels. Try to adjust the exposure levels manually to get your desired level of brightness on the end result.

White Balance
White balance is used by digital cameras to keep the colours looking as natural as possible in the picture. To do so, the camera analyses the scene to determine which area is truly white and adjusts itself to the rest of the scene accordingly. If the level of one colour (e.g. red) appears too high on the white part, the camera will automatically adjust itself to remove the same level of red from the rest of the picture to make it appear more natural.

Though most cameras do a pretty good job of adjusting the white balance, it is always a good idea to manually adjust the white balance in some lighting situations. For example, when a room is...
only lit with a yellow light bulb, the camera may have a tough time adjusting the white level automatically. You can easily set the white level to high through the camera’s menu system and thus get better results.

Scene Modes
Any digital camera worth its mettle has various scene modes that act as presets for most common situations. The camera adjusts its aperture, shutter speed and exposure to get a desired level. The most common scene modes are—

- Portrait mode is perfect for close ups and macro shots as it creates a reduced depth-of-field effect in which the subject is in sharp focus while the background and the foreground is blurred out.
- Landscape mode works well when you want everything in the scene to be in sharp focus.
- Sports mode sets the camera to a high shutter speed and continuous auto-focus to clearly capture a fast moving subject.

Other popular modes included on most cameras include the night shot mode that helps you shoot night photos—of surroundings,

A badly timed shot where the images appear blurred
and people—without the need for any special accessories or skills! Manual mode is another interesting although risky mode if you are a beginner with no knowledge of photography. It is in your interests that you leave the camera set to Auto mode where everything is taken care of at least initially. You can get creative slowly as you start grasping the basics better.

**SPORTS PHOTOGRAPHY TIP**

Anticipate where the action is going to be and position yourself accordingly. It could be horses bursting from the starting stalls or the winner crossing the line in a 100 metre sprint. Why do you think all the photographers sit themselves behind the goal at a football match? The action that makes the news doesn’t happen on the half way line very often.

**LANDSCAPE PHOTOGRAPHY TIP**

Landscapes are beautiful even in black and white. Obviously, if you want to capture the vivid colours of a landscape then black and white is not the medium to use, but if you are trying to portray a sense of desolation or isolation, then black and white can increase the impact. It’s all a question of your perception and sensibilities. What you want is what you should shoot.
1.5 Setting Up Your Digital Camera

It could be the first shoot of your life or a shoot on your trip, if you didn’t take some time off to prepare before the shoot, chances are you’ll feel the pinch when there’s nothing you can do to correct it. It’s always better to be safe than sorry, so here are a few things you should do before your first shoot, or before leaving on an excursion.

Charge your Batteries: For the first shoot, make sure that the camera batteries are fully charged. To get the maximum performance out of the batteries, always drain them before a recharge and don’t start using the camera before the battery is completely charged. If you’re going out for a shoot, make sure that the spare batteries are also charged.

Check Memory Space: It’s a good habit to unload your memory card to your computer immediately after any shoot. It doesn’t cause problems the next time you wish to go on a shooting spree.

TIP

Memory cards do go through wear and tear with time. So trusting all your pictures to one card with a huge capacity is a bad idea. Depending on the resolution and compression ratio you shoot at, use cards that hold about 80 images—so all won’t be lost if the card takes a dive.
Even the spare memory cards should be kept empty, after all there’s no such thing as ‘too much free memory’.

Setting up your Computer: Keep the drivers and the required software installed and ready to use before you shoot. If you have a laptop that you’ll be using to store your images on the move then pre-installing the necessary software can save you some precious time and laptop battery life.
1.6 Accessories For Your Digital Camera

Your digital camera may have bundled everything that you thought you may require, but if there’s one thing we know is that there’s always room for more. Most of these accessories are not really a must-buy for casual photographers, but if you’re a prosumer, you may want to consider accessorising.

**Batteries**: As we mentioned earlier, digital cameras are highly battery intensive so it’s highly recommended to keep at least one set of fully charged spare batteries on standby at all time. If your camera uses standard AA batteries, purchase two pairs of AA sized NiMH rechargeable batteries and use them instead of the standard disposable ones.

**Memory Cards**: A standard digital camera usually comes with a 16 or a 32 megabyte memory card which will definitely not suffice if you’re going on a trip. Getting a bigger memory card will give you more room to experiment with multiple shots and even give you storage space for great videos. And since memory cards can be used as a portable storage media, you can even get a memory card reader to make it a portable drive when not in use in your camera. All in all, investing in more memory is never a bad idea.

Here’s a chart that will help you select the memory card size to suit your needs:

**Bags and Straps**

<table>
<thead>
<tr>
<th>Sensor</th>
<th>16MB</th>
<th>32MB</th>
<th>64MB</th>
<th>128MB</th>
<th>256MB</th>
<th>512MB</th>
<th>1GB</th>
</tr>
</thead>
<tbody>
<tr>
<td>3 mp</td>
<td>13</td>
<td>26</td>
<td>53</td>
<td>106</td>
<td>213</td>
<td>426</td>
<td>853</td>
</tr>
<tr>
<td>4 mp</td>
<td>8</td>
<td>16</td>
<td>32</td>
<td>64</td>
<td>128</td>
<td>256</td>
<td>512</td>
</tr>
<tr>
<td>5 mp</td>
<td>6</td>
<td>12</td>
<td>25</td>
<td>51</td>
<td>102</td>
<td>204</td>
<td>409</td>
</tr>
<tr>
<td>6 mp</td>
<td>5</td>
<td>10</td>
<td>20</td>
<td>40</td>
<td>80</td>
<td>160</td>
<td>320</td>
</tr>
</tbody>
</table>

Most camera manufacturers generally provide a wrist strap and a little carrying pouch with the digital cameras. That’s usually good enough for a casual user, but advanced users may want to invest in a good quality digital camera bag that comes with extra space.
and slots for batteries and memory cards. If you’re going to carry multiple memory cards, this might save them from getting lost or misplaced in the luggage.

**Tripods:** When you’re zooming in on a faraway object or even taking a delicate macro shot, a slight movement of hand can cause the whole image to blur. Not everyone is blessed with steady hands, so these kinds of mistakes will happen. That’s where the tripod comes to the rescue. For generations, a tripod has proved to be a photographer’s best friend. With its stability, you can concentrate more on the composition rather than on keeping your hands still. It’s especially helpful for long-ranged zooms.

**Cleaning Kit:** Travelling photographers should consider getting one of these. The kits usually contain protective films for the LCD screens along with a blower, brushed and anti-static cloth to remove fingerprints and dust particles off the camera lens.

Accessories are based on your requirements and budget. There are a lot of things available that you really do not need and it’s a good idea not to invest in them. Far too often, photographers—amateur, hobbyist or professional—end up splurging too much money on accessories they will never use.
1.7 Basics Of Composition

This section does not only pertain to digital photography. Here we talk about some basic rules in photography that can dramatically improve your composition or give it the right focus that it may lack. So we present a few suggestions that may go a long way—

The Rule of Thirds: Considered by many as a golden rule of composition, this rule states that you imagine the viewfinder is divided into thirds, both horizontally and vertically. This grid creates four intersection points around the centre. Place your subject where the lines intersect, instead of placing them right in the centre of the frame. There is no harm in thinking out of the box and making a brilliant piece of art that breaks all stereotypes but it never hurts to have knowledge of the basic guidelines.

Attention to Framing: A messy dumpster at the corner of your picture or a bunch of wires and cables cluttered at the side of your subject could ruin the entire photo. Keep an eye out for undesired elements around your subject or in the background that could mess up the end effect completely.

TIP
Some of the best lighting conditions are to be found around dawn and again at dusk. Try taking pictures at these hours and notice the effect. The brightest sun of the day can wash pictures out. If the time of day when you take your pictures is not important, try to avoid the period around midday. This is when the sun is right above your head and causes ugly shadows under the eyes, nose and face apart from being harsh in nature.
Angles and Perspective: A shot of a person smiling straight into the camera is so clichéd! Try clicking fresh shots of old subjects by selecting different shot angles. Don’t feel shy to crouch on the floor or perch on one leg to get a good picture. The end result is what will stay with you in the long run.

Use Lighting to your Advantage: One major rule of composition is “Dark on Light and Light on Dark”. High contrast will usually make the composition stand out from the rest. You can also try playing with lights and shadows to get interesting results.

Most photographers like to believe they control the light that falls on the subject. This is truly the way to go. Light is what makes the photo and if you can truly control the light that is falling on the subject, your expression—the intended one—will surely come through.

Before this can happen, though, you need to understand and learn how light behaves. This can be as interesting an exercise as it can be frustrating. Light tends to do things contrary to your liking... as though it were governed more by Murphy’s Laws than any other!
Exercise: Find out the compositional faults in this photograph (if any) and list them. Try to shoot a similar photograph without any of the errors. Compare faults in your photograph (after judging it objectively) with the first list and rate your understanding of the composition.
1.8 Viewing And Transferring Images

Microsoft Windows XP users have it easy when it comes to digital camera connectivity. Most cameras are automatically detected and images are automatically transferred to the My Pictures folder. The default image viewer too is fast, light and convenient to use which will eliminate the need for casual users to install third-party image viewing/management utilities. If you need to do a little bit extra such as fixing small problems like exposure level, remove red-eye, crop, resize and also fix some common problems, then try a software package like ACDSee 7.0.

ACDSee makes a great companion to your digital camera as it has just about every feature an amateur photographer would need. It can acquire snapshots from your camera, help you eliminate minor issues, and also change the size of the image to an e-mail friendly format. It can automatically generate an HTML page with thumbnails of your snapshots that lead to the full-size, ready for you to post it on your Web site. For people who prefer printing the snapshots, ACDSee has a plethora of options for printing single or multiple images at a time. On the down side, ACDSee 7.0 is quite system heavy so you need to have a pretty decent configuration to run things smoothly.

There are some other software available for free including Picasa 2.0, Hello and more that organise and help you share your photos online. But more on that later in the book.

*INFO*
When viewing images using software such as ACDSee or even the Windows Picture Viewer, you can choose to change certain attributes of the images. Some of these offer to rotate the images either clockwise or counterclockwise and can also do minor re-touching to your images using Windows’ built-in Paint software. If nothing, these software present the images in a viewer-friendly format making them appear more attractive!
Now that you are familiar with photography and have also taken some photos, it’s important that you edit and improve the quality of your photos before you print or share them.

There are various ways of doing this, and range from basic editing to advanced manipulation. What we will look at here are the basic editing tools that will help you ‘clean up’ your images and make them print- or Internet-ready.
2.1 Introduction To Photoshop

There's a lot of software out there that lets you modify and clean your photographs to perfection, and frankly speaking, many of them are even more user-friendly than Adobe Photoshop. But the kind of flexibility and control you get with Photoshop is simply unmatched. Most of the imaging applications bundled with digital cameras are very user-friendly, but their features are quite limited in scope. With the flexibility that Photoshop...
offers, there’s always something new you can learn to improve your skills. Once you get familiar with it, there’s no way you’ll be looking at any other imaging software again.

In this section we talk about some of the basic things you need to know about Photoshop that will help you fix just about any kind of minor issues or glitches in your snapshots.

Before we begin, let’s familiarise you with some Photoshop basics. First we’ll take a look at the Photoshop interface.

There are a few aspects of Photoshop that you should familiarise yourself with right at the beginning so the steps ahead can be much easier.

**Layers:** In Photoshop, you can modify an image in layers. For instance, if you want to put

TIMESAVER TIP

Here's how to figure out what resolution to scan at: dpi (dots per inch) to set for scanning equals final image width divided by the original image width x the final ppi (points per inch) desired. So if you want to print an 8 x 10 inch enlargement from a 4 x 5 inch photo, divide 10 by 5 which gives you 2. Then multiply that by, say, 200. The result, 400, is the scanner dpi setting to use. To end up with 300 ppi you’d have to scan at 600 dpi.
some text on the image, you can do it on a layer above the main image, so just in case you’re not happy with the placement of the text, you have the freedom to move it around, modify it in any way you like and even delete it without affecting the layer beneath. Think of layers as plastic transparencies.

It’s always recommended to do all image modifications on a new layer. If you need to touch up the main image itself, then duplicate it first.

**Brushes:** Brushes are a very important part of using Photoshop, be it for image manipulation, red-eye removal or even stamping. That’s why it’s advisable to get used to the brushes in Photoshop as soon as you can.

**Filters:** In photography, filters are placed over the lens to add a new element to the picture. With filters you can make a picture look brighter, give a colour overlay, add a mosaic effect, etc. Effectively, Photoshop filters do the same thing, only you have a lot more variety of effects that you can add to a picture. There are already dozens of inbuilt effects that can make a photograph look like a water colour painting or a charcoal drawing; you can even add noise and scratches to give it an ‘old’ feel. Filters are fast, easy to use and very effective: that’s why you’ll find a variety of free and shareware filter plug-ins all over the Internet.

---

**TIMESAVER TIP**

Anti-aliasing: Open a new file, say about 30 by 200 pixels. Choose black as your foreground color. Click on the Type tool, then click on your file. This will bring up the Type dialog box. Make sure that the ‘anti-aliasing’ checkbox is checked. Set the type size to about 14 points, and type out ‘This is anti-aliased type.’ Now, for comparison, open another new file. Click on the type tool, then click on your file. Type out ‘This is not anti-aliased type.’ Compare the two files. See the difference a little anti-aliasing can make!
**History:** Let’s face it: if you’re new to Photoshop, you’re bound to make some mistakes in the beginning. The good thing is that all your moves are recorded as a history in Photoshop, so if you run into something that gives your picture some highly undesirable effects, all you need to do is go to the History panel and retrace your steps back to the point from where you want to resume ‘Photoshopping’.

The best way to learn Photoshop is by trying out all the features by yourself. See what everything does. Experimentation goes a long way. The filters, in particular, give you a lot of room for experimentation.
2.2 Manipulating Image Attributes

The good thing about digital photography is that once you’ve clicked a picture, it’s still open to all sorts of changes. If there’s something that doesn’t seem to fit in the picture, it can be easily dealt with. In this chapter we show you how you can change some basic image attributes, which can make a world of a difference to the end result.

**Basic Colour Manipulation:** Though you can set your digital camera to shoot in Black and White or sepia mode, there are times that you would have already shot an image in colour, and later on realised that it would look much better in black and white. Here are some simple Photoshop techniques that will help you achieve that.

**Black & White:** You can achieve this look the simple way or the hard way. The difference is that the light tones come out looking a lot better the hard way, but it all depends on whether you can be bothered with the technique. We’ll show you both the techniques, just in case.

The simple way to convert a colour photo to Black and White is:
- Open the photo in Photoshop
- In the Toolbar, select Image > Mode > Grayscale
- A pop-up will ask you if you wish to discard the other channels; click OK. You’re done!

The slightly harder way to do it requires a few more steps:
- Open the photo in Photoshop

**TIMESAVER TIP**

To create a border, open the photo you want to create a border around. Click the Quick Mask mode button in the toolbox. This will create a Quick Mask channel in the Channels palette. Choose the Rectangular Marquee tool in the toolbox, then select an area in the centre of the image. Choose ‘Fill...’ from the Edit menu. Fill the selection area with black at 100 per cent opacity. Choose None from the Select menu to deselect the area. Then choose ‘Gaussian Blur...’ from the Blur sub-menu in the Filter menu. Use a Radius setting of between 10 and 20 pixels. You have now applied the Gaussian Blur to the Quick Mask channel. Select any special effects filter from the Filter menu. Since you are still in Quick Mask mode and there is nothing selected, only the Quick Mask channel will be effected by the filter. Click on the Standard selection mode button in the toolbox. This will select the area of the image that is not masked by the Quick Mask channel. Fill the area with your background color, and you’re done.
In the Toolbar, select Image > Mode > Lab Color

Now in the Channels window, you will see the image divided into four channels, namely Lab, Lightness, a and b

Delete the channels a and b so that only Lightness remains (renamed as Alpha 1 channel)

Save the image in your required format

If you compare the image saved in Grayscale to the one saved in Lab Color mode, you’ll find that the overall luminosity is better in the latter.

**Sepia:** Sepia is a reddish-brown monochrome tint that gives a picture...
tute a warm, ‘antique’ feeling. It’s quite simple to apply the sepia
tone effectively in Photoshop using the following steps:

❍ Open the image in Photoshop
❍ Go to Image > Mode > Grayscale
❍ A pop-up will ask you if you wish to discard the other channels;
  click OK
❍ Go to Image > Mode > RGB Color
❍ Go to Image > Adjustments > Variations
❍ Move the Fine...Coarse slider down one notch less than the mid-
  dle
❍ Click on ‘More Yellow’ once
❍ Click on ‘More Red’ once
❍ Click OK

TIMESAVER TIP

JPEG (Joint Photographic Expert Group) or GIF? If the image contains
large areas of solid color or simple repeating patterns, use GIF. If the
image is more complex in colour, like a photograph use the JPEG compression.
When saving as a JPEG, as a generalisation never use more than 40 compres-
sion. You can apply a Gaussian blur to the image to reduce the file size. (Keep
it between 0.8 and 1.2 or it will affect the image quality)
Although it might seem okay on screen, it’s advisable you zoom in to find out at what percentage the image starts to get pixelated.
Refining Images for Printing: There may have been vast technological advances in monitors, but the best way to admire a photograph is still the good old fashioned photo print. After all, it’s only a print that you can frame and place by your bedside—and you definitely can’t carry a jpeg file around in your wallet. For a picture that means so much to you that you want it in print form, you need to make sure it’s done with the utmost care.

To get the best quality from your print you need to use at least a 300 dpi image. Just the way a digital image is composed of and measured in pixels, a print is measured in dpi (dots per inch). The lower the dpi, the more graininess you’ll notice in your print. 300 dpi is considered the industry standard for a good quality print. But chances are that your camera may not shoot at exactly that dpi, so you’ll need to address that in a simple Photoshop exercise.

- Open the image you wish to print in Photoshop
- From the toolbar, go to Image > Image Size to get the ‘Image Size’ window to open
- At the bottom of the pop-up window there will be a checkbox that says ‘Resample Image’. Take the checkmark off that box
- Now in the Resolution box, change the number to 300
- Click the OK button to close the box

You may not notice a difference in the image quality after doing this, but your printer definitely will. You can select the page layout in the printer driver options, along with the size you want to print.

Optimising Pictures For The Internet
Bigger may be better when you want to view your photos with all the intricate details at home. But if you want to share the picture on your Web site or e-mail it to your friends and family, then you have to consider the bandwidth limitations that come up. Sending a one-megabyte image file over the Net is not only time consuming, it also blocks the receiver’s bandwidth during the transfer process. You may even end up blocking someone’s e-mail inbox with your last trip’s photo album. If you have anything over a one-megapixel camera, make sure you optimise the photos before posting them on the Net or sending it to other people. Here are a few Photoshop steps that show you how.
Open the image in Photoshop
From the toolbar, go to Image > Image Size to get the ‘Image Size’ window to open
In the Pixel Dimension section, check the size of the image in pixels
If it is anything over 1280 x 960 pixels, make sure the ‘Constrain Proportions’ checkbox is checked, and resize the larger number (from the Width and Height boxes) to 640 or 800 or 1024, or a maximum of 1280 (depending on how big you want the image size to be)
Click OK
Now click on File > Save for Web
In the Save For Web window, select JPEG Medium in the Preset section. If the image appears with graphical artefacts, then select the JPEG High option instead
Save the image
You will notice that the file size has dramatically reduced from the original, without much noticeable quality loss. Your picture is now ready to distribute online.
2.3 Fixing Common Image Problems

Let’s face it—sometimes, even when we take all the precautions to take a perfect picture, something doesn’t end up right. The snapshot may look fine on your camera’s LCD screen, but when you view it in full size on your monitor, you start noticing some problems. The good news is that most of such minor problems can be fixed in Photoshop. Here’s a look at some common issues.

**Incorrect Exposure Levels:** This is an exercise we advise for all images. Even if you feel that the exposure level is just right for

**TIMESAVER TIP**

Creating a ‘newspaper look’: Choose Image > Mode > Grayscale. If you have to choose whether you wish to flatten the image or not, choose to flatten it. Give it a bit more contrast: choose Image > Adjust > Brightness/Contrast, and drag the contrast slider to the right to somewhere around 20. Now pick the Color Halftone filter: Filter > Pixelate > Color/Halftone. Set Max. Radius to 4 (the minimum). Now if you want smaller dots, however, do it like this: Make the image larger, say 200 per cent, and apply the Color Halftone filter with the same settings, and then shrink the image back to its original size. You may think that this result looks better.
your image, try playing around a bit with the levels in Photoshop and look at the difference. We’re not asking you to always make changes in your clicked photos, because sometimes, imperfect exposure works great for the feel of the picture. But still, seeing what a little level adjustment can do won’t hurt anyone, and can always be undone. So how does one adjust levels? Simple just open an image in Photoshop and press [Ctrl]+[Shift]+[L]. You will instantly notice a difference in the lighting and the colours of the image.

If you want a bit more control, you can adjust the Brightness and Contrast settings manually by going to Image > Adjustments > Brightness/Contrast. Move the brightness and contrast sliders around until you’re satisfied, and click OK—or just cancel if you think you’ve done something wrong.

**Colour Correction:** There are times when a camera can’t seem to get the white balance of an image perfect, and sometimes you just wish to give the image a tinge of some extra colour that would enhance the mood of the overall composition. It’s times like these when the Color Balance tool comes into play. This is what you need to do:
Open the image in Photoshop
Press [Ctrl] + [B] on your keyboard to open the colour balance window
Play around with the sliders until you think you’ve got a dominant colour that adds more mood to the picture
Click OK to accept the changes or Cancel to undo

Cropping: If there are some unwelcome distractions in your picture, like a man walking in from the edge, or if you seem to have captured so much background that the subject gets lost somewhere in between, the crop tool is exactly what you need. To use the crop tool:
Open the image in Photoshop
Press [C] on your keyboard to select the Crop tool
Select the area you wish to keep on the image
Press [Enter] on the keyboard, and you’ll have the image cropped to the selection

**Red-Eye:** Red-eye reduction can be very tricky. If not done right it can make eyes look very unnatural, which could get quite distracting. We’ll show you a great method to remove red eye from images. It may be a bit complex for a beginner, but the results make it worth it.

Open the image in Photoshop
At the bottom of the layer window, click on the circular icon that stands for ‘Create new fill or adjustment layer’ and select the Channel Mixer option there

Removing the Red-Eye (right) from the original (left)
In the Channel Mixer window, set the Red channel to 0 per cent, Green to 50 per cent, and Blue to 50 per cent. Don’t panic when you get an off-colour image.

Now select black as your foreground colour, making sure the Channel Mixer layer is selected, and press [Alt]+[Backspace] to fill it up with black.

Now select the foreground colour as white, and use the brush tool to paint over the red portion of the eyes. It’s preferable to select a brush size that matches the size of the red eye.

Notice the red eye disappear as you paint over it.

**Resizing Images:** There are many situations where you’ll need to get an image to fit into a specifically sized space. If you’ve been trying to resize graphics and they’ve ended up squished horizontally or vertically, this tip should help you out.

Say the size of your image is 584 by 400 pixels. We need to resize the image so that the final size is 200 by 300 pixels.

To find out the size of your image, select Image/Image Size from the Photoshop menu bar. This dialog box gives you the width, height and resolution of your image. You’ll see a checkbox next to the word Proportions. Don’t uncheck that checkbox—your image will be squished if you do.

You need to change only one dimension. Photoshop will then do the math for you and figure out how big the other dimension needs to be in order to retain the correct proportions for your image. Which dimension do you change? Select the dimension that will need to change the most. In this example, we’re changing an image that is 400 x 584 to 300 x 200. The height dimension in...
this example needs to change the most, so we’ll change the height from 584 to 200.

Photoshop scales the width size proportionately, making the image 137 pixels wide.

Now you’ll need to change the width of the image. You don’t want to use the Image/Size for this. Instead, we’ll use the Image/Canvas Size function. What the Canvas Size does is to add pixels to your image, and it fills them with whatever background color you have selected. Canvas Size changes the size of your image by adding to it, leaving the original image unchanged. The Image Size command changes the size of your image by anti-aliasing it.

Change the width number from 137 pixels to 200 pixels. The Placement graphic gives you a choice of where the extra pixels will go: to the left, to the right of your image, or on either side of your image. Leave the original image centred, which is the default. Your image should now be an almost-perfect rendition of the original image, constrained in its proportions.
2.4 Fun and Games

Once you have a picture in digital format, there are a lot of fun things you can do with a few image manipulation techniques. You can place your face on a Wanted poster, superimpose your face on the body of a superhero, make yourself stand in front of places you’ve never really seen in your life. The options are limitless.

Teaching you how to do complex image manipulations is beyond our scope here, but we can teach you a basic technique that you will be using a lot - superimposing yourself on a different background using the Photoshop Quick Mask mode.

The Quick Mask mode lets you use the brush, pencil, paint bucket, etc. tools to paint an ‘inverse selection’. When you switch back to Normal mode, the clear or unpainted parts of the masked image are selected so that you can apply changes. It may sound complex but it’s not, really.

- Open the image in Photoshop
- Click the Quick Mask icon in the tool palette to switch to Quick Mask mode
- Using a fairly large brush with the foreground colour set to
black, paint the background. The large brush size makes it convenient to paint the main areas of the background fairly quickly.

- You can then use smaller brushes to fill in the details around the edges of the foreground.
- If you made a mistake, all you need to do is switch the foreground of the brush to white, and it will act as an eraser to the mask.
- You will eventually have the entire background coloured in pink.
- Switch back to Normal Mode, and you’ll see that your subject has been selected.

Now click the Layer Mask icon at the bottom of the Layers Palette to create a layer mask, which essentially isolates the selection from the rest of the image.

You’re free to add any image you want as the background to your subject. This technique can be used for a fast masking job on even...
the most complex manipulations. In fact you can use this technique to create innovative frames and borders for greeting cards, or any other application you can think of.

Using the Magic Wand

The picture above is a photograph with a ‘clean’ background. You can achieve this by simply using a sheet or wall behind the object when you’re clicking it. Now, the image will be ready for superimposition on anything you want. How you do it is, simply select the Magic Wand tool from the toolbox, and click once on the picture area. This will select the object in the photograph—in this case, the hand—and reject everything around it! Now copy the selection, and paste it onto any other photograph.
Now that you have shot a bunch of digital photos, it’s time to get an opinion on them or just share them with friends and family. How would you like to do it? Would you like to upload them to a Web site, share them in an online album, or just make old-fashioned prints? The choice is yours. Learn more about the various ways of sharing your digital photos.
3.1 Software To Organise Your Digital Photos

Usually, you don’t realise the importance of being organised until you need a particular photograph and have to search through 5,000 others before you find it. Sorting a collection of thousands of pictures could drive you to suicide. Thank God for photo organising software!

Let’s take a look at two of the most renowned photo organisers (or electronic photo albums) available today—Picasa and Adobe Photoshop Album.

**Picasa 2**
Calling Picasa a photo organiser is an understatement, because it is capable of doing so much more. If you are a casual digital camera user or amateur photographer, Picasa is the clear-cut solution to most of your problems.

The first time you start Picasa, it automatically locates all your pictures and sorts them into visual albums organized by date—all you have to do is sit back and wait. The best part is, it’s free!

Here’s a brief list of things you can do with Picasa.

**Organise Your Photo Collection:** As we mentioned earlier, Picasa organises your entire picture collection and automatically sorts them by date. You can do simple file organisation like moving pictures into their proper folders, batch renaming a collection of photos and adding gold stars to your favourite pictures to make them easy to locate. Options such as password protection keep your private photos safe from prying eyes.

**TIP**
The number one flash mistake is taking pictures beyond the flash’s range. Pictures taken beyond the maximum flash range will be too dark. For many cameras, the maximum flash range is less than fifteen feet. What is your camera’s flash range? Look it up in your camera manual. Can’t find it? Then don’t take a chance. Position yourself so subjects are no farther than ten feet away.
Editing And Tweaking Photos: Picasa 2 features some ‘Basic Fix’ buttons that make it fast and easy to crop, remove red eye and fix levels and colours of your digital photos. You can even add visual effects such as sepia, black and white, among various other options.

Organising a photo collection that’s more than a couple of hundred pictures large can be nerve-wracking.

TIP

If you are photographing outside on a grey, dull day, keep the sky out of your pictures wherever possible. Also, try using different viewpoints. Taking shots from high up looking down can provide you with interesting perspectives. When shooting a horizon, try to place it either a third of the way from the bottom or a third of the way from the top. Avoid placing it in the middle.
Backing Up And Sharing: Picasa also has backup options that allow you to burn your photos to a CD or DVD. Sending photos via e-mail is easy, as Picasa automatically resizes and attaches pictures to e-mail messages at smaller sizes that your friends will definitely appreciate. There's also 'Hello', an inbuilt instant picture chat that lets you share pictures while chatting.

Printing Your Photos: Just as a good photo organiser should, Picasa automatically fits your pictures perfectly onto the paper that your printer uses. It's easy to print wallets, 4×6, 5×7, full pages and even more than one picture on a page to save expensive photo paper.

Other Fun Stuff: If you have enough time to kill, you can try Picasa's movie-making capabilities. Just select the pictures, adjust the delay time, dimensions, and video compression settings, and Picasa will render a movie, complete with title graphics. You can also create screensavers, posters and collages of your favourite shots.

Adobe Photoshop Album 2.0

No, this program is not an add-on for Photoshop. Photoshop Album is a fast, easy way for digital photo aficionados to organise, fix, share, and archive pictures without breaking a sweat.

---

**TIP**

Carry a notebook with you and write down the details of each photo you take, especially the expected result. If the final print is exactly how you intended, then that’s great; if not, learn from the photograph and think how you can succeed next time. Use this tip and you should soon see an improvement in your photographs. Also remember that in general, you should follow certain rules of composition—such as the rule of thirds.
The need to organise and tweak photos to perfection has plagued amateur photographers for as long as they have been clicking. Photoshop Album 2.0 has a great balance of keeping things simple, while addressing the most vital needs of a digital photo collector.

**Photo Organiser**

With the unique calendar interface and the brilliant drag and drop tagging function, finding a particular photo requires no more than a few seconds. Photoshop Album eliminates the dependence on traditional folders and file names.

**Tweaking To Perfection**

Most of the simple adjustments such as colour balance, levels and sharpness, can all be fixed with a single click. Even some advanced features such as red eye removal, rotating, and cropping pictures are possible with the same simplicity. There are also options for visual enhancements such as Black & White and sepia conversions.

**Backup And Easy Sharing**

The advantage of Adobe Photoshop album, being an Adobe product, is the ability to create PDF files. Since Acrobat Reader is a fairly common software, you can simply distribute PDF photo albums over the Internet. If you prefer watching your albums on a bigger screen instead, you can even make video CDs out of your albums.

**Making Prints**

You can take prints of just about any size you desire, along with multiple prints per page, which will make the best use of your photo paper. You can also create greeting cards, calendars and photo albums using the pre-installed templates, which you can also personalise.

**TIP**

Remember that night shots demand certain things of you—that your hands be steadier than usual; that you need longer exposure times; and so on. (One exception is with fireworks—a shorter exposure time works better.) Adjust the ISO setting higher on your digital camera to allow the use of a faster shutter speed. The higher the ISO/ASA, the shorter the exposures you can use—which partially remedies the need for steadier hands, amongst other things.
Other functions:

Some other great functions include creating Web-based photo galleries, e-cards, calendars, adding captions to photographs, and even 3D walk-through galleries. A very unique feature about Photoshop Album is that you can send your pictures directly to your Palm PDA or mobile phone.

Adobe Photoshop Album is not freeware, but if you want a demonstration of its functions, you could get the Adobe Photoshop Album 2.0 Starter Edition from www.adobe.com.

TIP

About B&W: Stormy weather shots are often captured in a more dramatic way using black and white film. Black and white can make elderly people look even older. Dilapidated buildings and run down areas of a town or city can appear more striking in black and white. Use black and white film in conjunction with coloured filters for a variety of differing effects.

TIP

Card Readers: There’s a cable with every camera that connects it to your computer. But leaving your camera on while you load pictures into Adobe Photoshop Album or onto your hard drive takes lots of battery power. Use an external card reader and save on batteries. Pull your memory card out of your camera and put it into a card reader connected to your computer and your digital camera will have plenty of juice when you need it.
3.2 Printing Your Digital Photos

If you’ve been wondering why, even after buying yourself a great photo printer and using the best quality paper, you can’t seem to match the quality of prints you get from photo stores, chances are you haven’t really been optimising the picture for the perfect print. Sure there’s a variety of software out there that offers to print for you, but if you don’t mind spending a little extra time, then here are a few suggestions that can make your prints stand out from the crowd.

First, if you’re taking pictures for the purpose of printing, always shoot them at the maximum resolution your camera has to offer. For a better idea, just follow the table below to check how big your picture needs to be in order to fit it to a particular print size.

<table>
<thead>
<tr>
<th>Print Size (inches)</th>
<th>Good Results (200 dpi)</th>
<th>Best Results (300 dpi)</th>
</tr>
</thead>
<tbody>
<tr>
<td>4 x 6</td>
<td>800 by 1200 pixels</td>
<td>1200 by 1800 pixels</td>
</tr>
<tr>
<td></td>
<td>(about 1 megapixel)</td>
<td>(about 2 megapixels)</td>
</tr>
<tr>
<td>5 x 7</td>
<td>1000 by 1400 pixels</td>
<td>1500 by 2100 pixels</td>
</tr>
<tr>
<td></td>
<td>(about 1.5 megapixels)</td>
<td>(about 3 megapixels)</td>
</tr>
<tr>
<td>8 x 10</td>
<td>1600 by 2000 pixels</td>
<td>2400 by 3000 pixels</td>
</tr>
<tr>
<td></td>
<td>(about 3 megapixels)</td>
<td>(about 7 megapixels)</td>
</tr>
<tr>
<td>11 x 14</td>
<td>2200 by 2800 pixels</td>
<td>3300 by 4200 pixels</td>
</tr>
<tr>
<td></td>
<td>(about 6 megapixels)</td>
<td>(about 14 megapixels)</td>
</tr>
<tr>
<td>16 x 20</td>
<td>3200 by 4000 pixels</td>
<td>4800 by 6000 pixels</td>
</tr>
<tr>
<td></td>
<td>(about 13 megapixels)</td>
<td>(about 29 megapixels)</td>
</tr>
</tbody>
</table>

First, if you’re taking pictures for the purpose of printing, always shoot them at the maximum resolution your camera has to offer. For a better idea, just follow the table below to check how big your picture needs to be in order to fit it to a particular print size.

That said, it’s not a good idea to print a large image on a comparatively smaller-sized paper. It can be done, but the results may not look as good as it would if you take a little time to resize the image to fit the print size. The reason for this is that most inkjet printers are not capable of scaling down images efficiently. You may find jagged edges, artefacts and other such errors if you try printing an enormous image on a smaller paper. For a guide on resizing images and optimising them for print, refer to Section 2.2.

**Some Tips To Perfect Your Print Quality**

- Premium glossy photo paper gives the best results when printing photos. The gloss tends to bring out better colours overall.
Always select the proper paper type in the print preferences, or your printer will not print to the paper’s optimum quality.

If you are getting lines or bands in your prints, use the printer’s utility functions to clean up the head and nozzle.

Make sure your printer’s colour ink cartridge has ample amount of ink left. Replacing a near empty cartridge can improve picture quality.

TIP
Turn off the Date Function on your digital camera, and any other such features that the manufacturer supplies. If you really want to remember when the photo was shot, use another method such as naming your digital file with the date in the name or, if worse comes to worst, writing the date down in a notebook as you are out shooting. The idea is to eliminate distracting elements whenever you can.
3.3 Sharing Your Photos Online

Long gone are the days when you had to snail-mail out photo prints to your friends and relatives in order to share them. Also gone, now, are the days when you could only e-mail out photos—sharing your photos online is where it’s at now. We tell you about a couple of sites where you can store photos for your friends and family to view.

**Webshots**
www.webshots.com
Webshots is a great place to share your personal photos with the world. You get an option to create multiple albums with as many photos as you wish. Each photo appears as a thumbnail in the main album page. If you click a thumbnail, you’ll be taken to a bigger size. This is especially good for users who don’t know much about resizing and optimising for the Web, as Webshots will do all that for you. So although you have a five-megapixel photo stored...
in your album, a visitor will only see the resized version of it before he chooses to view it at full size.

With Webshots, you get to track how many people have viewed your albums and the number of downloads per image, which allows you to determine how popular your albums been. If you don’t have any particular privacy issues with sharing your pictures with the world, Webshots is the place to be.

**DeviantArt**

www.deviantart.com

While family albums can find numerous spaces on the Web, amateur artists and photographers find nirvana at DeviantArt.

---

**TIP**

Shoot, shoot, and shoot. Shoot a few pictures a week and it will take you forever to become a good photographer. But shoot a couple of hundred shots a week and you’ll progress a lot faster.

As a rule of thumb, never shoot less than six to ten pictures of a subject. Explore it from different angles, go for different poses, stay with it, trying with each new shot to make a better picture than the one before.
DeviantArt provides you with unlimited space to express yourself through your art, be it photography, photo manipulation, sketching or even writing. Your uploaded images are displayed as a gallery, where fellow artists can comment about your work and add it as a favourite if they like it enough. You can even maintain a journal, or join clubs that will expose you to other artists in your field. The options are limitless.

For more information on sharing your photos online, refer to Section 4.1.
After all this know-how you have picked up, you must be itching to create your own photo gallery. Well, there’s nothing to stop you. It’s normally advisable if you give yourself an assignment when you set out photographing rather than wander aimlessly looking for a photo. If you already have something planned like a vacation or an event or if a festival is round the corner, nothing better! We provide you some tips and practical examples of how you could handle such situations best. Happy Shooting.
4.1 Shooting For The Internet

When shooting for the Internet, image quality is definitely not the topmost criterion. In Section 2.2, we showed you how you can reduce the size of your pictures and optimise them to make them e-mail friendly. If you want to skip all that post-processing and tackle the problem at the source, you need to change some settings in your digital camera. A lot of digital cameras these days come with an ‘e-mail mode’ feature that automatically sets the camera to shoot in low resolution. If your camera doesn’t have this mode, you need to manually set your camera to the lowest possible resolution—typically 640 x 480. Pictures shot at 640 x 480 have the optimum pixel resolution for e-mail or Web sites; anything lower than that is just not worth the kilobytes you save on.

Liven Up Your E-mails

When sending pictures to your relatives or friends, there’s a lot you can do to make the e-mail more appealing than just sending photos as attachments. If you’re using an e-mail client such as Outlook Express or Mozilla Thunderbird, you can use their inbuilt HTML editors to embed the pictures in the body of the mail. The advantage here is that you can add captions beneath the photos, and even arrange them the way you want them to be seen. You can go crazy with formatting—adding lines, tables...
and even backgrounds to really give the e-mail a photo album effect. Though it may be time consuming, your recipients are sure to appreciate the effort.

**Create Your Own Gallery**

There are many free gallery services available on the Internet, like the ones we mentioned in Section 3.3. But if you prefer to create a gallery with your own personal touch, here are a few steps you can follow:

- Get a Web hosting account: Depending on what your budget and aim is, you can get a .com Web site and hosting through a commercial Web hosting company, or a free account at hosting providers such as Geocities (http://geocities.com).
- Generate a thumbnail gallery: This is once again dependant on your budget. If you’re planning a commercial site, you can have your site professionally developed by Web designers. However, even casual users with no knowledge of HTML can generate galleries using software (featured in Chapters 1.8 and 3.1), or by using the Web page generators available on most free Web hosting servers.
- Upload and update: The good thing about a customised Web page is that you can make it your personal blog, art gallery or just a simple family album. Our advice? Keep it fresh with constant updates that will keep visitors coming back for more.

---

**TIP**

Do your shots sometimes have a cool, clammy feel to them? The default white balance setting for digital cameras is Auto, which tends to be a bit on the ‘cool’ side. When shooting outdoor portraits and sunny landscapes, try changing your white balance setting from auto to cloudy. Why? This adjustment is like putting a mild warming filter on your camera. It increases the reds and yellows resulting in richer, warmer pictures.
4.2 Shooting Your Travels

Even the most casual of photographers make the most of their cameras during vacation. The sad thing is, not many of them have anything new to look at, which can really take its toll on those forced to view your photographs. Let’s examine some dos and don’ts of vacation photography.

A Different Look At The Same Subject

The front shot of the Taj Mahal (top image on the right) has been done so many times that even those who have never visited it can vividly describe the front lawns. Instead, shoot from a different angle, say, lying on the ground, looking up at the main archway. Take a silhouette shot of the Taj Mahal—just don’t shoot the kind that you see on postcards. This extra effort will make your gallery unique enough for people to notice and remember.

TIP

If you really want to add some punch to your images, get your hands on a polarising filter. By reducing glare and unwanted reflections, polarised shots have richer, more saturated colours, especially in the sky. If the digicam cannot accommodate filters, simply use a pair of good sunglasses as your polarising filter. Place the glasses as close to the lens as possible, then check their position in the viewfinder to make sure you don’t have the rims in the shot. For the best results, position yourself so the sun is over one of your shoulders. The polarising effect is strongest, more so, when the light source is at a 90-degree angle from the subject.

This view of the Taj Mahal has been done so many times, no one may want to see your ‘version’ of it

Even a slight change in angle, like in this photograph, can make the Taj look interesting again
Interact With Your Surroundings
If you are shooting a family member or friend with the backdrop of a monument, the one thing you don’t want to do is make your subject stand impassively in front of the monument staring at the camera. Shots like that are sure to elicit yawns from those who view your album. Instead, you should make the subject interact with his or her surroundings. Bring out the emotion that the subject is going through about being there, be it happiness or even gloom or boredom. Even negative feelings will make a better shot than just standing there with luggage and staring at the camera. Be careful of the type of interaction though, as some of those shots can be overdone. For instance, the illusionary shot of a person pushing the Qutub Minar to make it tilt has been done to death.

Shoot The Journey
You probably don’t need us telling you this, but it’s a good idea to take pictures of your journey too, not just your destination. Get a picture of you driving your car, getting up a train or just trekking with your backpack. Once again remember, the picture is not just about you, but about what you are doing. You driving the car will always make a better and more interesting shot than you standing in front of it and waving your hand.

A good shot of the Gateway: it doesn’t face it bang on, and you’re not just standing in front of it
You in your car is a better shot than you in front of it
4.3 Restoring Photographs

As time progresses, memories become more valuable, and the best form of memories are photographs. They are a representation of days gone by, a slice of your history. Unfortunately, they don’t stand the test of time unless they are kept under ideal conditions and adequately looked after. A picture of your grandfather during his prime may hold a lot of emotional value, but can be almost unrecognisable today. It’s a good thing that technology today can help restore such photographs.

We recommend that you let the professionals handle something as vital as this, but there are a few things you need to know.

Basic Photo Enhancement

The first step in photo restoration is to scan the picture, so that you can edit the digital version without causing any further damage to the original. Once scanned, you can use various Photoshop techniques to make the picture clearer, such as changing brightness, contrast and noise reduction, for example. Have a look at Section 2.3 for more information on colour correction and level settings. A slight colour correction to reduce or add the sepia effect can give you good results.
Complete Photo Restoration

Sometimes, old photos are so badly damaged that the print has almost completely been replaced by the whiteness of the paper. It is impossible to restore such photos to their original splendour. You can, however, use a popular technique called airbrushing to improve the pictures.

An actual airbrush is a mechanical brush that uses no bristles to apply the paint. Instead, compressed air is forced through a fine nozzle to break up the paint into an ultra fine mist. This effect can be effectively replicated in Adobe Photoshop with precision. Through this technique, the missing elements of the picture are literally drawn back into the photo. The end result may not look extremely real, but it’s the best restoration technique available for completely damaged pictures. You can even convert old black and white photos into colour using the airbrush technique.

Tip

One of the great hidden features on digital cameras is the fill flash or flash on mode. By taking control of the flash so it goes on when you want it to, not when the camera deems it appropriate, you have taken an important step toward capturing great outdoor portraits. In flash on mode, the camera exposes for the background first, then adds just enough flash to illuminate your portrait subject. The result is a professional looking picture where everything in the composition looks good. After you get the hang of using the flash outdoors, try a couple variations on the theme by positioning the subject so the sun illuminates the hair from the side or the back, often referred to as rim lighting. Another good technique is to put the model in the shade under a tree, then use the flash to illuminate the subject. Remember that most inbuilt camera flashes only have a range of 10 feet, so make sure you don’t stand too far away when using fill flash outdoors.
4.4 Your Autobiography In Photos

Here’s a special project you can start: a pictorial autobiography. Once you get a digital camera, making a biography of your life is practically effortless. The biggest drawback of owning a film camera is that you have to get the pictures scanned. The good thing about the digital medium is that you can turn your biography into a screensaver, a video CD or an Adobe Acrobat PDF document for easy distribution (refer to Section 3.1). Here are a few ideas you can use on this project:

- **Start with a family tree:** You can start your autobiography with a family tree, starting from pictures of your grandparents all the way down to your grandchildren (as and when they come along). You can make the tree as comprehensive as you like: after all, it’s your family genealogy!

- **Open with baby shots:** If you had shutterbugs for parents, you are likely to have a few thousand photographs of you as a kid. If not, track the few pictures of you as a child that exist and use them to start your album. You can even start with your parents for added effect. Remember, if you or your parents do not have pictures of yourself as a kid, try contacting your friends or their parents—chances are there is a picture of you in a group photo at your friend’s third birthday party!

- **Avoid clutter:** It’s best to keep an autobiography brief! No one wants to see a day-by-day pictorial narration of your life. Keep it simple and clean so that people will remember it.

With a digital pictorial autobiography, you can update and change content to keep people interested. Add some humour in your captions that will make your family members say, “Awww! So sweet!”

---

**TIP**

Even the simplest object takes on new fascination in macro mode. Just look for the close up or macro mode icon, which is usually a flower symbol, turn it on, and get as close to an object as your camera will allow. Hold the shutter button down halfway to allow the camera to focus. When the confirmation light gives you the go ahead, press the shutter down the rest of the way. Keep in mind that you now have very shallow depth of field, so focus on the part of the subject that’s most important to you—and let the rest of the image go soft.
4.5 Night Photography

There’s something about night photography that captivates us. There’s a mystical feel that a photographer gets when shooting after dark. The shadows and the selective lighting give your creativity the outlet it was seeking. Alas, what you see with your eyes is never what you capture with your camera. And the solution? Turn off that flash!

Keep It Stable

Do your pictures look like you shot them while travelling on a bullock-cart on some of the worst roads in your city? Were you actually trying as hard as possible to remain motionless when clicking? Chances are, you’ve been cursed with the worst possible combination in photography—a digital camera and shaky hands. This problem is only made worse at night, and if you want to be able to shoot better photographs, get a tripod or place your camera on a sturdy, stationary surface when clicking. You can also use the self-timer function on your camera to completely avoid blurry images—position the shot, set the timer and gently click, so that when the camera actually clicks the photograph, you are not touching it, causing it to shake.

Higher Exposure

If you’re shooting at night, chances are that you want every hint of available light captured. For example, when shooting a cityscape from the top of the building, you would want to

---

**TIP**

When you’re figuring out the budget for your next digital camera, make sure you factor in the purchase of an additional memory card. Why? Because the included cards are about as satisfying as an airline bag of peanuts when you’re dying of hunger. If you have a two megapixel camera, get at least a 64 MB card, 128 MBs for three megapixel models, 256 MBs for four megapixels, and 512 MBs for five megapixels and up.
To start with, change your exposure settings to ISO 400—or even ISO 800 in case you do not get the desired effect at first. This setting will allow you to capture light at a faster rate, which is a necessity for low lighting at high shutter speeds.

If you have the option of keeping the shutter open for a longer period, try setting this between three and five seconds to allow the light to settle. Remember, if you keep the shutter open for too long there may be some multi-colour artefacts—it’s best to stick to fast shutter speeds at higher ISO levels.

**TIP**
The digital push is a two step process that helps to capture sharper images in low light. This technique can also be used in daily hand-held situations of low light and high zoom: When in doubt, set a higher shutter speed for safety, and brighten the exposure later with image processing. The slow shutter speeds needed to make a good exposure in low light can often lead to camera-shake, a common cause of a ruined photograph. You can usually save an underexposed image, but there is no cure for motion or camera blur.
Blur effects

Ever notice the linear lights on the road created by car headlights in photographs shot at night? The easiest way to create this effect is to use a very slow shutter speed. If you want, you can deliberately move the camera during the exposure for varied effects. You can use this blurring light technique to captivate some great compositions. For example, shoot a Giant wheel (Ferris wheel) from a tripod with a very slow shutter speed, and you will get all the stationary portions of the scene in sharp quality with some brilliant light effects on the moving parts.

Shooting Fireworks

This can be especially tricky, since most people make the mistake of using longer exposures to capture fireworks when in reality it works the opposite way. Capturing fireworks with long exposure

TIP

For landscape photos, it is very often a good idea to get down. So many good landscape shots miss the chance to be great simply because we lift the camera to our faces and shoot. This may capture the inspiring scenery, but from a head-height perspective that we are all unconsciously accustomed to. Simply getting low to the ground can improve your results a lot and make your photo stand out.
It may seem intuitive to use a slower shutter speed when trying to capture fireworks, but that’s wrong—it’s actually faster shutter speeds that work better.

will mostly end up generating artefacts on the picture due to bursts of fast moving lights. Use low exposure settings and a tripod when shooting fireworks.

These are just guidelines, not absolute rules. You should try playing with your digital camera settings to get different results. Experimenting is what will help you in the long run, and with a digital camera, it won’t cost you a thing!

**TIP**

- Trust your eye: Studying the laws of composition is fine, but when it comes down to it you must trust your eye. When you frame the shot, move the camera and explore the scene. When you find an angle or composition that feels good to you, take the picture immediately. You can (and should) get several more shots.

- Train your eye: Look at the pictures you have taken and critique your own work. Did all the images turn out like you had planned? Were you happy with the composition? This self-review stage is essential for you to improve your photographic “spider-sense”.

- Know your camera: you don’t need to memorise every feature right away, but over time you should be comfortable enough so that operating your camera becomes second nature. It is like learning to shift gears or ride a bicycle—only when the machine becomes transparent are you really driving.
4.6 Photographing Children

Shooting children is exciting. Unlike adults, children are less aware of the presence of a camera, and are almost always captured in very natural poses. Unfortunately, sitting still is hardly natural for a child, so you should be prepared to move a lot when looking to photograph children. Here are a few basic guidelines to help you get better results and show you what you should or shouldn’t do when photographing kids.

**Shoot At Eye Level**

That’s the child’s eye-level, not yours. The world looks very different from a child’s eyes, and if you shoot from the level that they see everything at, chances are you will end up with interesting results. Sit on the ground and take your photographs—not only does this put you at the right height, it also helps steady your shots. Of course this doesn’t mean that you shouldn’t be creative and use different perspectives: lying down to make the child seem bigger or perhaps even shooting from high looking down on everything.

**Keep the subject comfortable**

Some children get a bit nervous when they become conscious of the camera pointing at them. It’s up to you to get the camera-shy

---

**TIP**

Again, for landscape shots, tilt forward. Enhance the impact of your immediate location in the context of the whole by tilting your camera forward and focusing on what’s immediately in front of you while keeping the rest of the landscape in the picture.

Also, shooting from just inside a treeline or through a bunch of tall grass or flowers will heighten the sense of being in the landscape.
child to relax and do his or her own thing. Never tell a child to look directly into the camera—in fact, let the child play around the location when you are taking the pictures. Bring in a couple of the child’s friends or your family dog, to make the child more comfortable with the surroundings.

Candid Shots
Photographing a child in his or her own element can capture a level of innocence that you never achieve with a ‘posed’ shot. Take snapshots while the child is playing, watching TV, reading, or just about doing anything. You never know where you may strike gold and get that shot of a lifetime.

Lighting To Go With The Mood
As we mentioned earlier, light is the essence of photography. The right light setting will accentuate the mood of the child. Happy
children look much better in bright sunlight and colourful environments. For a picture of a sleeping child it’s better to shoot in soft light, such as light filtering through a window. You can experiment with different lights to match the moods.

Patience Is A Virtue
When photographing a child, learn to have a little patience. Only three or four of every 30 pictures will be worth saving. And remember, getting impatient and hot under the collar, or trying to manipulate the child into what you think is a great shot, just does not work. With a digital camera, all you need to do is delete photographs you don’t like!
4.7 Nature Photography

Nature photography is one of the more enjoyable fields of photography. It may take longer to get somewhere, but the time is more enjoyably spent because you are more aware to the world around you and are observing it with a photographic eye.

Although you can take nature pictures with any camera, once you get serious about it, you’ll find that certain equipment gets you better results.

Basic equipment
Photographing wild flowers and other small natural objects for a number of years might require you to invest in similar equipment eventually if you are getting serious about it:

Lenses including a 100 mm macro lens with extension tube and a 28-135mm zoom lens. The zoom lens is used as frequently as the macro lens, because many flower photos work best when the
Close-ups like this one can be tough yet satisfying to shoot

flower is shown in context. When using a point-and-shoot type digital camera, you could use both normal and macro modes, depending on how close you want to get.

**Tripod**

Starting from an aluminium version, that also costs about half the price of the carbon fibre version, you could choose from a wide range when it concerns prices and quality. You need to remember, though, that you should be able to perform certain actions like rotate the centre shaft into almost any position, for example. This does two things. It gets the centre shaft out of the way so you can spread the legs farther apart so the camera is lower to the ground. It also cantilevers the camera out to the side for better angles in some situations.

**Markins Ball Head**

For years, people have struggled with a three-way head, mainly because the alternative, a ball head, was expensive. With a tripod that can set the centre post at any angle, it can get tough to monitor and set three adjustments and a limited range of movements.
An L-bracket from has two mounts that let you quickly mount the camera in either the horizontal landscape or vertical portrait orientation. Normally, to move the camera into a vertical position, you have to swing it over so it hangs off to the side of the centre column. With this bracket it remains centred over the tripod, a much stabler position.

Various small cameras those are easier to carry. It is advisable that you invest in cameras that have a monitor that tilts and swivels. A quality bag to carry it all together is the final and most important requirement. If your bag is flimsy, your equipment investments could soon go south. It’s never a waste investing in a good bag that can withstand the elements at least.

Reflectors, diffusers, and light tents are all collapsible and used to control the light and block the wind. In bright sun it’s nice to have a diffuser to soften it and lower the contrast.
Even your own garden can be a good ‘venue’ for nature shots

**Basic Techniques**

The techniques you use depend on the situation, but generally include the following:

Manual focus is almost essential so you can position the plane of critical focus at just the right spot. In close-up photography about half of the available depth of field is in front of the plane of critical focus and half behind it.

Exposure compensation with auto exposure bracketing (AEB): Not all cameras have this mode but it lets you capture a series of shots at slightly different exposures. You can often specify the difference in exposure (1/3, 1/2, 2/3 or 1 full stop) and the number of exposures in the series.

Sequential burst mode runs off the series of exposures as I hold down the shutter button.

Self-timer or manual shutter release: Which should be used depending on the situation again. If it is calm with no breeze at
all, it’s a good idea to use the self-timer. It eliminates any possibility of introducing blur when you press the shutter button. If you want to get really sharp images, use the mirror lockup (available in DSLRs). If there is any breeze, keep your finger on the shutter button and when there is a pause in the breeze and the plant stabilises, press and hold it down to shoot the series.

It takes practice but you can press the shutter button so smoothly and slowly that it doesn’t shake the camera. Sometimes, you could hold it halfway down if the breeze is about to stop. This sets exposure and means you only have to press it the rest of the way to quickly take the pictures.

To make the best use of available depth-of-field, compose the shot so all of the important elements fall on, or close to, the same plane.

**Wind and Sun**

Without question, the two biggest problems you have when photographing flowers is the wind and the sun; with the wind being the worse of the two. There have been wind blown photos taken at a slow shutter speed and they looked great. You can almost feel the wind in them. For most purposes, however, blur is your enemy. Luckily, on most days even when there is a breeze, there will be slight pauses when it’s calm. You just have to be patient and wait.
until just the right moment. In many cases the calm is so short you can’t use the self-timer because the breeze may have resumed by the time it takes the picture.

Close-ups versus Context
The way you compose an image depends partly on what your goals are. If your primary interest is taking photos that can be used by others to identify plants, your photos could be of the documentary type. If you are interested in being more impressionistic, there are no rules at all.

Playing the Angles
Shooting down is the normal angle but getting down at eye-level, or even shooting up is a unique view. If you want things sharp, try to have them all fall in the same plane and have the camera parallel to that plane.

Flash
You could also try using a flash whenever it’s dark or windy. The flash has a high speed sync mode that lets you shoot at about 1/2000 sec to freeze plants in motion. Another advantage of flash is that you can use it in combination with exposure compensation to darken the background.

The dimmer the light and the farther way the background are, the darker it will be in the shot. This lets you get great depth of field without the background becoming a distraction. The flash also has a control so you can increase or decrease the power of the flash. By using these two controls together you can have almost complete control over the lighting of both the foreground illuminated by the flash and the background illuminated by ambient light; a mind-boggling combination at most times.
Backgrounds

Backgrounds make or break a photo. A flower photographed against a busy background gets lost. If the background is out of focus and soft, a sharp flower will stand out against it. Luckily, depth of field in close-ups can be quite shallow so it’s usually not a problem making the background soft. You just open up to a wide aperture such as f/2 or f/3.5 and focus on the flower. Anything behind the flower will be soft and the farther away it is from the flower, the softer it will be.

One special technique is to use a light tent. You could cut the bottom out of it to position it over a flower. It not only softens and diffuses the light and cuts the wind, when positioned in the right way, it gives you a uniform grey or white background. This kind of background is very easy to select in a photo-editing program, so you can remove it all together, replace it with a different colour, or even cut and paste the flower into another scene. If the background is busy, this is time-consuming if not impossible.
In this Tips & Tricks special, we cover photography in general, scanning your images and processing your digital photos ......................... 120

We also show you how you can use PhotoShop Album to easily manage your photo collection ......................... 124

Mexy Xavier, our in-house photographer, on how the Delete button can cause so much trauma ......................... 128
Photography

Use these tips to breeze through a photo shoot using a digital camera!

Focusing
You might face this problem if you use an auto-focus camera—the camera captures the distant background and blurs the subject. This is because cameras are usually designed to have a central focus. The solution is quite simple. Point the camera at the subject and position it in the centre of the frame. Keep the shutter button pressed halfway down to lock the focus on the subject and re-position the camera so the scene is framed to your liking. Finally, press the shutter button down completely to take a snapshot.

The Rule Of Thirds
One of the most popular rules of photography, it applies to both traditional, as well as digital photography. According to this rule, if the frame of the viewfinder were to be divided into thirds, both horizontally and vertically, then the four intersections are the best places to put your subject, instead of the centre of the frame. This yields an appealing image.
In case of a landscape shoot that needs an emphasis on the sky, get the horizon on the lower horizontal grid.

**Foreground And background**

Zoom in and choose a large aperture setting for sharper foregrounds and blurred backgrounds. This setting is appropriate for portrait photos. Zooming out and choosing a small aperture results in an equal focus on the background and foreground.

**Shooting Fireworks**

Snap up those beautiful fireworks using a digital camera with a shutter speed longer than ½ a second. Ideally, opt for a shutter speed between 2 to 10 seconds to capture all the sparkle and razzmatazz. You will also need a tripod to avoid jerky, haphazard photos. Eliminate even the slightest possibility of vibration by using a camera that comes equipped with a remote shutter release.

Set ISO to the lowest setting to reduce noise—the tiny dots across such snaps. Enable long exposure noise reduction, if the camera comes with it.

Preview the shot on the LCD screen.
and accordingly adjust the aperture so that it’s just the right size to get bright sharp photos. Keep spare batteries with you.

**Warm Tones**

Normally, the default white balance setting for most digital cameras is set to ‘Auto’. Though this is fine in most cases, sunny landscapes and portraits taken in bright light could turn out dull. Hence, change its setting to ‘Cloudy’ to get warmer reds and yellows that make the picture look better.

**Polarising Filter**

Polarising filter is used for outdoor shoots since it reduces glare and reflection, and results in more saturated colours, especially in the case of sky. Use your sunglasses in case your camera doesn’t have support for one. Place the glasses as close to the camera as possible, check the LCD to see that its frame does not obstruct the view and shoot. For better results, use it when the light source and the subject are at right angles, i.e., when the sun is exactly over your head. Further, set the white balance to ‘Cloudy’ for warmer photos.

**Flash Modes**

Normally, digital cameras have three flash modes—Auto Flash, Fill Flash and Red Eye Reduction.

Auto Flash mode is used for general photography. In this mode, the flash determines whether it needs to be fired or not, based on the amount of light present. This mode is represented on the LCD by a lightning icon with a capital ‘A’.

In the case of Fill Flash, the flash is always fired. This is useful when the subject is

Incorrect usage of a flash can make even the cutest of puppies look evil
sitting in the shade with bright sunlight around. If set to Auto, the flash would not have fired, resulting in dark spots around the eyes. In the Red-Eye Reduction mode, the flash is fired several times before the shutter actually opens. Thus, the eye-pupils are contracted and the red-eye effect reduces. Use this mode when there is very little light and the photo depends on the flash.

**Snapping Water**

A camera with a shutter speed that’s slower than a second or two can be used to shoot flowing water and make it look like a painting. Set your camera on a tripod. Adjust the aperture either to f-8, f-11, or f-16 for better depth of field. Now, set the shutter speed to 2 seconds, and shoot. Since you are using long exposures, make sure that the subject is positioned in the shade. Use polarising filters to enhance the effect.

**Master The Modes**

Digital cameras have many presets, called modes or macros that let you click photos differently. Some of the common modes are

---

Making a waterfall look like a painting
Auto, Portrait, Landscape, Sports and Night. Auto mode is the general picture-taking mode. When you use this mode, the exposure, focus, and flash are set automatically. When this mode is active, there is usually a small camera icon on your LCD to indicate it. Portrait mode, usually shown on the LCD as a face, sharpens the subject and leaves the background out of focus.

Landscape mode is indicated by mountains on the LCD, and is suited for shooting subjects that are at a distance. Often, a slower shutter speed is chosen and hence, it’s better to use a tripod while using this mode. The Sports or Action mode provides a faster shutter speed and is used to shoot fast moving objects. Night mode, as the name suggests, is used to shoot in poor light conditions. Since this also means longer exposures, use of a tripod is recommended.

**Slideshows And Screensavers**

To view your pictures as a slide show in Windows XP, open the images folder in Windows Explorer and click on ‘View as slide show’ under Picture Tasks in the Common Tasks area. Alternatively, right-click any image, select Open With > Windows Picture and Fax Viewer. Once the image is opened, press [F11] to start the slide show. You can also view this slide show as a screensaver. Right-click the desktop, select Properties and choose ‘My Picture Slideshow’ in the Screen Saver tab. Click on Settings to specify the folder and other settings.

In case you use Windows 98, or intend to create a screensaver file, use utilities such as Irfanview (www.irfanview.com). In Irfanview, click File > Slideshow, specify the

---

**Use XP’s ‘My Pictures Screen Saver’ option to view your photos as a screensaver**
folder and other settings, and click on ‘Save as .scr’. Save this file in C:\Windows\System in Windows 98, or C:\Windows\System32 if you use Windows XP.

**Taking Silhouettes**

Silhouettes make for appealing photographs. To shoot a silhouette, first position yourself with the sun somewhere in front of you. Now, set the exposure on the brighter part of the scene. Use the exposure lock button to secure the exposure. Re-compose the photo and shoot. If it doesn’t have an exposure lock button, set the exposure compensation to -2 or -3.

**Transferring Pictures**

There are two ways to transfer images from a digital camera to a computer. One is tethering, wherein the camera is directly connected to a PC using the cable provided with it. This can be slow and cumbersome and drains the camera’s batteries, unless it has an AC adapter. The other way is to use a CardReader. Simply insert the memory card of the camera into the reader, and connect the reader to the PC. Most readers don’t require separate drivers and support all major card formats.

**Download Pictures Automatically**

You can configure your digicam in Windows XP to download pictures automatically when it’s plugged in. However, the camera should either have the Windows Image Acquisition driver, or support Picture Transfer Protocol (PTP). Right-click
the camera icon in My Computer, and choose Properties. Go to the Events tab, click ‘Save all pictures to this folder’ and specify the folder. Now, whenever you connect your camera, the pictures will be automatically downloaded to that folder.

**Care And Maintenance**

Carry your camera and other accessories such as memory cards, batteries, cleaning kit and tripod in a separate bag. Keep your camera covered with a plastic bag to protect it from moisture. Also, place some silica gel bags along with it to absorb moisture.

Never use paper tissue or napkins to clean lenses. They contain scratchy wood products and may damage the coating on the lens. Use a camera-cleaning kit that includes special brushes and a lens-cleaning solution. Keep the bristles of the lens-cleaning brush from coming in contact with your hands as body oil gets transferred onto them. After cleaning with a brush, put a drop of lens-cleaning solution on a lens-cleaning tissue, and clean the lens in circular motions.

Avoid high temperatures as these affect the camera. When in bright sunny light, keep the camera covered in a white towel when not in use. Keep the camera away from strong magnetic fields, as it may damage its memory card. Finally, remove the batteries and store them in a dry cool place if you do not plan to use the camera for a few weeks.

**Develop Your Style**

Pictures don't always have to be sharp to be good, perfect exposures don't always give the best results, camera angles don't always have to be the same. Digital photography is so inexpensive, you shouldn't feel the need to get every shot perfect. It's likely that your photographs won't be interesting if you don't take chances and explore new approaches. When you find a situation that catches your eye, shoot it from a variety of positions. If you have a zoom lens, use it. Try using exposure compensation. Keep experimenting and trying new techniques:
occasionally do things 'wrong' deliberately. The work that goes into those results that appear interesting can be applied in other situations. Eventually you’ll find your distinctive, personal style that allows you to convey the world to others from your own, unique viewpoint.

**Look In Your Backyard**

One mistake many photographers make is to think they have to go to unique places to get unique photographs. This leads you to ignore the possibilities nearby and at-hand.

Because we admire the work that great photographers did in scenic locations - like Ansel Adams at Yosemite - we often think we have to go there too! What's often forgotten is that these people were shooting in their own backyards. They knew the area and its lighting intimately. They took photographs of the same places over and over again from different vantage points and under different lighting to build their skills.

To build your skills, photograph the same things over and over again as the light changes. Try different points of view, and different angles and compositions. You have no excuse not to do this because unlike these earlier photographers, you're not spending money on film when you try new things.

**Play With The Horizon Line**

When photographing outdoors, one of the key elements in many images is the horizon line and where you place it in the image. Some photographers like to follow the rules, and place the horizon line so it's one-third up from the bottom of the image. This rule may give interesting images, but you'll do better trying different things. Despite what some people believe, there are no rules in photography. If there were, photography would be a lot easier than it really is.

**Look For Unusual Atmospherics**

In the rising or fading light at dawn and dusk, you can often see unusual lighting in the sky. One approach to photographing these scenes is to place something interesting
in the foreground. Also, bracket your exposure so you have a variety of images to choose from.

**Explore Reflections**

Reflections can add a lot of interest to a photo - and they are everywhere. Day and night, they are on the water, in windows, and on any shiny, reflective surface.

**Play With Shadows**

Bright sunny days may look beautiful, but they aren't the best days for photography. The hard, direct light casts black shadows everywhere. But shadows are interesting - you just have to think about them and where they fall. Too often we notice just the bright part of the subject when composing a picture.

**Play With Patterns**

Patterns are everywhere - you just have to practise noticing them. Some have a centre of interest; many just an unbroken rhythm that makes them interesting.

**Look For The Unusual**

If you keep your eyes open for scenes that are humorous or interesting in any way, you'll be surprised at what you might find. You just have to be ready to capture them when you see them.
Analogue To Digital

A scanner lets you get that lovely picture on to your desktop. Using these nifty tricks to convert your analogue pictures to digital!

**Buying A Scanner**

Before buying a scanner, you need to keep your budget in mind and evaluate the scanner on the following points:

- Resolution, measured in dots per inch (dpi), determines the sharpness of the scan. Typical flatbed scanners offer a resolution ranging from 600 to

---

Use the Descreen filter when scanning printed material.
2400 dpi. The second factor is Dynamic Range. Scanners that reproduce white perfectly have a minimal optical density or Dmin of 0.0. On the other hand, scanners that output a perfect black have a maximum optical density or Dmax of 4.0. These two values constitute the dynamic range of the scanner. Typical values for these are 2.5 and 3.5.

Another factor is the Bit Depth. This is concerned with the analog to digital conversion of images, during scanning. Typically, scanners have 48-bit conversions, with 16-bit each for red, blue and green. The next feature that you should consider is the speed of scanning. Though there is no standard method of measuring the speed, you can compare the time taken to scan the same image at the same settings by different scanners.

Finally, look for transparency adapters for scanning slides and negatives, Automated Document Feeders (ADF), etc. If you are looking for any of these features, make sure that you buy a model which come with these accessories, as buying them separately is expensive.

<table>
<thead>
<tr>
<th>Printer Type</th>
<th>Standard inkjet printer</th>
<th>High-quality inkjet printer</th>
<th>Photo-quality inkjet printer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Resolution</td>
<td>300 to 320 dpi</td>
<td>600 to 720 dpi</td>
<td>1,200 to 2,880 dpi</td>
</tr>
<tr>
<td>Scan Resolution</td>
<td>150 ppi</td>
<td>150 to 240 ppi</td>
<td>240 to 360 ppi</td>
</tr>
<tr>
<td>Printed Size</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2 x 3-inch</td>
<td>300 x 450 pixels</td>
<td>400 x 600 pixels</td>
<td>600 x 900 pixels</td>
</tr>
<tr>
<td>4 x 6-inch</td>
<td>500 x 900 pixels</td>
<td>800 x 1,200 pixels</td>
<td>1,200 x 1,800 pixels</td>
</tr>
<tr>
<td>5 x 7-inch</td>
<td>750 x 1,050 pixels</td>
<td>1,000 x 1,400 pixels</td>
<td>1,500 x 2,100 pixels</td>
</tr>
<tr>
<td>8 x 10-inch</td>
<td>1,200 x 1,500 pixels</td>
<td>1,600 x 2,000 pixels</td>
<td>2,400 x 3,000 pixels</td>
</tr>
<tr>
<td>Actual Pixel Dimensions (Average)</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Calibrating The Scanner
Calibrate your scanner every one or two months for optimum results. Calibration involves scanning a known colour and adjusting the output to match that colour. In case the scanner doesn’t support calibration, get a standard gray (RGB=128, 128, 128) reference colour card from a photo lab, and scan the image along with it. Open it in Photoshop and press [I] to activate the Eyedropper tool. The Info Palette shows the RGB values as you move the mouse pointer over the colour card. If it matches with the actual colour (RGB = 128, 128, 128 in this case), your image colours are perfect. Otherwise, change the colour balance and brightness of the image until you get the precise reference colour. Finally, crop out the scanned reference colour card.

Scanning Magazines
Scans of magazines or newspapers often result in dotted image patterns, commonly referred to as moiré. Minimise this effect by scanning the image at 300 dpi with the scanner software’s Descreen filter on, and then re-sizing it to 33 per cent of its size using photo-editing software such as Photoshop. Finally, apply the Unsharp Mask filter.

Scanning Line-art
Line-art is a clip art, drawing or pencil sketch, consisting of two colours. There are three methods of scanning line-art. The first is the Black and White Mode, or 1-bit scanning that just picks up the black areas. This method suits line-art that does not have shades akin to that of pencil sketches as it keeps the image size to the minimum. Remember to re-size

Use the Line-art mode in the scanner software to scan Line-arts.
and rotate at the time of scanning, to preserve the final image quality.

The other method is the grayscale mode, or 8-bit scanning that records shades of grey. This results in much larger files, but it's suitable for line-art with shades. The third method—halftone—is a format that prints black dots in a manner that simulates shades of grey.

**Scanning For Fax**

Scanning at 200 dpi in Line Art mode, 100 per cent is most suitable when the image has to be faxed. The easiest method would be to print the image to the fax driver directly from your scanner program. Fax always uses the Line Art mode—even if you scan it in some other mode, the fax software converts it into Line Art.

**Scanning Oversized Images**

If the image to be scanned is larger than your scanner glass, but its longest side is smaller than the double the longest side of your scanners glass, you can follow this method:

Make a mark after every eight inches on the longest side of the image from the right to the left. Now, rotate the image by 180 degrees and mark it in the same manner, on the opposite longest side. Here, we assume that the image has a landscape orientation, i.e., its width is greater than its height. Now, align the upper-right corner of the image with that of the scanner glass. Choose the settings at which you want to scan the whole image and start the scan. Save this file as Image1.tif.
Move the image to the next mark and scan without altering the settings. Save this file as image2.tif. Repeat the process till you have scanned the entire image. To scan the lower half of the image, turn the painting by 180° and repeat the above process. This time use a different naming convention like lower1.tif, lower2.tif. This is necessary because we will have to flip these lower images before creating the final image.

Open all the images in Photoshop. Create layers for each image by clicking Layer > New > Layer from Background. Rotate the canvas by clicking Image > Rotate Canvas > 180° for all the lower-half images. Create a new blank image, large enough to accommodate all these images. Put all the layers on this image and align them appropriately to get the final picture. You can also use Photoshop CS’s (Creative Suite) Photomerge feature to automate the last step.

**Saving Scanned Images**

Save images scanned to be used on the Web or be sent as e-mail attachments in the JPEG format. GIF is a better option for images such as line arts that have less than 256 colours since it results in smaller file sizes.

If you plan to edit the images later, save them in an uncompressed format. You may also save them in the TIF format as it allows compressing without causing loss of image quality. If you are scanning images for archival, it’s always recommended that you save one copy in your image editor’s native format. For example, if you use Photoshop, save a copy in the PSD format. You might want to save the second copy in high quality JPEG format.
Snapped and scanned, but satisfied you are not? Here’s how you add that touch of class to your digital images!

**Reducing Red-eye Effect**

Eye pupils dilate in the dark, thus reflecting the flash light in the eye’s blood vessels. This gives the person a ‘red eye’. Hence, avoid photographing in the dark. If it’s absolutely necessary, use a camera with red-eye reduction feature.

Tell the subject do not look directly into the lens. If possible, use a removable flash that is placed at some distance from the camera. You may also use photo management software such as Photoshop album, Picasa, ULead Photo Explorer, JASC to remove red eye.

**Cropping**

Cropping is used to edit unwanted portions of a photograph. Maintain the aspect ratio for prints when cropping using software. For example, if you need a 5 x 7 print, you will need to crop the image precisely to that size. Open Photoshop and press [Ctrl] + [R] to enable rulers. Right-click on the ruler, and select Inches to change the ruler unit. Now, drag the horizontal
guideline to 5 inches, and position the vertical guideline at 7 inches. Press [C] to switch to the Crop tool, and drag a rectangle of 5 by 7 inches. Move it to a suitable position, and double-click to crop; trying unusual shapes may be a good idea. For example, heart for a couple’s photo. Cropping comes handy while correcting horizon lines or straightening your photos.

Automated Features

Improve the quality of your photographs by using the automated functions in Photoshop. Go to Image > Adjustments > Auto Levels and then apply Auto Contrast and Auto Color. Finally, sharpen them via Filter > Sharpen > Sharpen.

Sharpening

You can sharpen any image using Photoshop’s Unsharp Mask filter (Filter > Sharpen > ‘Unsharp Mask…’). This compensates for the blurring caused by the low-pass filter that is found in almost all digital cameras to improve image quality. Apply it before the image is re-sized, or resampled, but after other corrections have been done. Its ideal settings would be a radius value of 0.3 to 0.5, threshold value of 0 to 2 and amount between 200 to 500 per cent.

For compensating the blurring done by output process, it should be sharpened after resize/resample. Generally, finer the print, the lower will be the radius. For example, you will need a radius of 1.0 to 1.5 for photos that are printed on premium inkjet photo paper.
Wipe Off Dust And Scratches
Make use of dust and scratch removal software to get clean scans. One such plug-in is Kodak's Digital ICE (www.asf.com). Apply the noise filter to the photo in Photoshop by going to Filter > Noise > 'Dust and Scratches...'. Next, despeckle the image by going to Filter > Noise > Despeckle.

You may also use the Clone Stamp Tool to clone a cleaner area to the dusty one. To use this Photoshop tool, press [C] and click on an area that resembles your target area, while holding down [Alt]. After defining the source, release [Alt] and paint in the normal way. Do remember to zoom in and keep the brush size smaller for better results.

Creating Panoramas
The latest version of Photoshop CS comes with Photomerge—a feature that allows you to create panoramas in just a few clicks. The best part is that you don’t even need to fix your camera on a tripod while taking images, as Photoshop adjusts the level automatically. Open Photoshop CS and click on File > Automate > Photomerge. Click on Use Files and use the browse button to locate all the images that want to use for creating the panorama. Make sure that the ‘Attempt to Automatically Arrange Source Images’ check box is checked, and click OK. A dialog box with your images identified and adjusted comes up. Click OK to accept and use the Crop tool to crop out unnecessary portions. Visit www.panoguide.com—a Web site dedicated to creating panoramas, for more tips and software.

Create an impressive panorama in minutes using Photomerge in Photoshop CS!
Distortion Correction

Distortion in photographs could be Barrel distortion—a lens effect that leaves photos with a spherical distortion at the centre, or it could be Pincushion distortion, which results in images that are pinched in the centre.

An easy solution to correct this would be to use the Panorama Tools plug-in for Photoshop that can be downloaded from http://home.no.net/dmaurer/~dersch/Index.htm. Open the ZIP file, and extract the pano12.dll file in the folder where Photoshop is installed.

Now, extract all the files inside the ‘Photoshop Plugin’ in the ZIP file to the Photoshop Plug-Ins or Filters directory. Restart Photoshop and open the photo in need of correction. First, go to Filter > Panorama Tools > Correct to bring up the ‘Correct Options’ dialog box. Select Radial Shift, and click on the option next to it to bring up the ‘Set Polynomial Coefficients for Radial Correction’ dialog box. Set ‘a’ and ‘c’ to zero for all colours, and choose a value for ‘b’ and ‘d’ such that their values add up to one. The values for ‘b’ should be negative to correct barrel distortion, and positive to rectify pincushion distortions. Start with 0.015 for ‘b’ and 0.085 for ‘d’ to correct pincushion, and -0.015 and +1.015 for barrel distortion. Increase or decrease the values gradually until the images are corrected properly.

Refer to the Readme.html file inside the ZIP file for further details.
Warning!
There are two ways to rotate images in Windows XP. You can right-click on the thumbnail view in Windows Explorer and choose ‘Rotate Clockwise’ or ‘Rotate Counter Clockwise’, or use the rotate image button in Windows Picture and Fax Viewer. However, every time an image is rotated, it’s saved, which results in some loss of quality. Thus, make it a point to use specialised photo-editing software that save only the final image. If you use Photoshop, it would be best to keep saving the image that is being worked upon in the PSD format. Save it in the JPEG format only when you’re done with all the editing. The use of the rotate image function in Windows XP should be the last step of your editing process.

Image Resolution
Perhaps the most important thing to keep in mind while printing images is the resolution. Ideally, a 4 x 6 inches photo should have a resolution of at least 800 x 600. For 5 x 7 prints, it should be 1024 x 768 and for 8 x 10 prints, it should be 1600 x 1200 pixels. Furthermore, you need to have a dpi of 300 for sharper, clearer prints. Use Photoshop to change all these parameters. Access them by going to Image > Image Size.

Tinting Black And White Photos
Using photo-editing applications, you can add colour to black and white photos. Open the image in Photoshop. Go to Image > Mode, and ensure that the colour mode is RGB or CMYK. Now, press and hold down [Shift] and use the Lasso tool to select a certain area, say, the skin of the photographed person. That done, go to Image > Adjustments > Variations and adjust the levels to obtain the desired colour. Now, select other elements in
the photograph and adjust the colour variations in the same manner. Use the Path tool for better control over selections.

Finally, create a new layer with ‘soft light’ blending mode and 85 per cent opacity. Now, use the dodge and burn tool to lighten and darken the specific areas to finalise the image.

**Print Easy**

The easiest way to print your images is to use the Photo Printing Wizard in Windows XP. Open the image folder in Windows Explorer, select the images you need to print while holding down [Ctrl] and then click ‘Print the selected pictures’ under Picture Tasks. Follow the instructions to print your images in Full Page, Contact Sheet, 8 x 10, 5 x 7, 4 x 6, 3.5 x 5 or Wallet prints.

**File Naming**

By default, images downloaded from a digital camera are named as DSCN0001, DSCN0002, ... Use the batch function in Windows XP to rename them. Open the image folder in Windows Explorer, hold down [Ctrl], select all the desired images and press [F2]. Name them appropriately and press [Enter]. If you entered ‘birthday’, the last selected file will be renamed ‘birthday’.
and the preceding files will be renamed ‘birthday (1)’, ‘birthday (2)’, etc.

**Photos On The Web**

Windows XP’s Web Publishing Wizard stores photographs online, as private or public albums. Open the folder that contains your photographs, hold down [Ctrl] and select the pictures you want to share. Next, click ‘Publish the selected items to the Web’ under ‘File and Folder Tasks’ to start the Wizard. After you have confirmed the photos you want uploaded, specify its location to the Service Providers in the next screen. Here, we choose MSN Groups—the standard option. The wizard then gives you the option of keeping your files public or private. Accordingly, you are asked the name of the group and a few other details as part of the registration process. It then displays the Web address of your group. Finally, the Wizard uploads the photos.

**E-mailing**

To e-mail photographs, right-click the image in Windows Explorer and choose Send To > Mail Recipient. A dialog box in Windows XP provides you with three options to re-size the image prior to e-mailing it: 640 x 480 strictly for computer viewing, 800 x 600 for 4 x 6 prints and 1024 x 768 for 5 x 7 prints. Of course, you can always send it as it is!

**Histogram**

Exposure is one important factor that differentiates good photos from shoddy ones. A good photo has all its elements illuminated properly. Use the histogram to correct exposure. Though many cameras show a histogram on their LCDs after you take a picture, it’s better to view the histogram in a photo-editing tool and make corrections there. Access the histogram in Photoshop by going to Image > Adjustments > Levels.

The right side of the histogram shows the lightest portion or ‘highlights’ of the images, the middle section shows the mid-tones and the left most side shows the darker portions or ‘shadows’.

The vertical axis shows the pixels in each level. An underexposed
image has many pixels concentrated in the shadows. Move the sliders to improve the distribution of brightness levels.

Alternatively, use the Auto button to let Photoshop make the adjustments. Further, you can also adjust histogram of channels, i.e. red, blue and green, if their distribution appears improper. For example, adjust the histogram for the blue channel if the sky looks dull in your photograph.
Photoshop Your Album

Let’s take a look at how Photoshop Album makes managing images a snap.

**Importing Images**

The first thing you need to do is import images directly from a camera, a scanner or from your hard drive. To import images, click on Get Photos in the taskbar, and select the appropriate option from the drop-down box. You can import images as well as audio and video files. If you are importing from a camera or scanner, you will have to provide a destination folder and an image format. If you already have Adobe PhotoDeluxe or Activeshare albums, you can import from them as well. To import these albums, go to File > Get Photos and choose PhotoDeluxe Album or Activeshare Album. You can also customise the arrangement of images into Catalogs. Go to File > Catalog > New Catalog, to create a new catalogue. Thus, if your computer has many users, each user can catalogue their images separately.

**Tagging Images**

Once you have imported your images, you have to organise them. Without image management, this is a cumbersome task, as you can’t have an image in two groups without putting them in both group folders, thus wasting disk space. With image management software, each image can be associated with one or more tags.

To tag images, click on Organize in the taskbar—you will see a list of tags on the left. The tags also have sub-categories, for example, under People you will find Family and Friends. To add a tag to an image, click on an image, select the desired tag and click on Attach in the left pane. You can also drag and drop a tag onto an image. Do this for multiple images by selecting the images (using [Ctrl]) and dragging and dropping the tag, or by selecting Attach.

All tagged images are displayed as an icon on the bottom-right
corner of the image. Hovering the mouse over this icon will show a tool tip with the tags added to that image. To remove tags, just right-click on an image and select Remove tag—you will see a list of tags assigned to that image. Select the ones you want to remove, and click OK. Two important tags are Favorites and Hidden. When you assign the Favorites tag, it is given precedence when searching. Similarly, when an image has the Hidden tag, it does not show up in the search results. To display hidden images, you have to select Hidden as well as your desired Search tag, when searching.

Searching

There are many ways to perform a search in Photoshop Album. Above the thumbnails, you will see a ‘Find’ bar. You can drag a tag to this bar to search for all files matching that tag. Dragging and dropping an image to this bar will search for all images similar to it. After a search is done, all images are sorted into two categories, viz, those that match and those that don’t. To perform a search based on other parameters such as filename, media type, etc, you have to use the Find menu in the menu bar. From here, you can also search for images classified as ‘Unknown date or time’ and those with no associated tags. You can sort images based on fields such as date, folder location, and so on. The current field being used is displayed as the button name. Adjacent to that button, you can find buttons to change the layout of the screen, rotate the current image, show or hide the properties pane, etc.

Image Editing

Using Photoshop Album, you can edit general errors in images. Select an image and click Fix in the taskbar. This brings up the Fix Photo window. On the right, you’ll see different tools—Single Click Fix, Crop, Red Eye Removal, Brightness and Contrast, Lighting and Color Saturation.

On the top of the window is a tab called ‘Before & After’; select that tab to see a comparison of the image after a change is made to the original file. If you want to make some general improvements to the image, try the Single Click Fix first. There
are four controls for it—Auto Color, Auto Levels, Auto Contrast and Sharpen. Just click the button, and the program will adjust the image correspondingly. After you make the changes, the system will save the image in the format ‘originalfilename_edited. filetype’—so ‘digit.jpg’ will be saved as ‘digit_edited.jpg’.

Archiving

Photoshop Album provides both backup and archiving features. You can restore the program to exactly the way it was, before taking the backup. This offers protection against any data loss or other anomalies. To create a backup, go to File > Backup, and choose between a Full backup or Incremental backup. The former does a complete backup, while the latter only saves all the data since the last backup. The data can be written onto a CD directly, or saved as a file. To restore the information go to File > Restore. Archiving is a feature whereby you can select images to be archived, and the system writes the images to CD. A low resolution version of the image will be maintained on your hard disk. When you try to use an archived image, you will be prompted to insert the CD.

Creations

Using the images in your collection you can create albums, slideshows, video CDs, greeting cards, e-cards, calendars and photo books. These are called Creations. Select all the images you want to use, and click on the button to the right of the Fix button. This will bring up the Creations wizard that will guide you step-by-step through the process of building the desired creation.
There is a creation called Adobe Atmosphere 3D Gallery that can be accessed through the Creations menu in the menu bar. It is a unique method of sharing your photos online with others—your photos are placed on the walls of a virtual gallery building, where users can go around in 3D space to view your images. There is even provision to allow multiple visitors to view the gallery at the same time. Select the images to be shared and start the Atmosphere 3D gallery. Then, in the pop-up menu that appears, select the style of the 3D room that you want—a preview of the room will also be shown. Then enter other details such as the size of the images and the title of the gallery.

The program will output a set of documents to a folder as in the menu, and will start the gallery automatically after exporting the files. But to view the gallery in a browser (only Internet Explorer is supported), you have to download the Adobe Atmosphere player from www.adobe.com/products/atmosphere/downloadplayer.html.

After installing the player, open the index.html file in Internet Explorer to start the 3D gallery. You can upload these documents to the Internet, and others with the player can view the gallery and can even interact with each other.
Damn Delete Button!

Digit's photographer Mexy Xavier recounts her woes of accidentally deleting pictures.

The problem with cameras today is that every button and its resulting menu are a little too easily accessible. And what's more, as a shutterbug, I never seem to ever have enough space for photographs. Though, effectively, I have 1 GB of space for photographs (on two 512 MB compact flash cards) sometimes I wish cameras had hard disks attached to them.

It was just one of those days: I had barely walked into office and I found out that I would have to leave immediately for a shoot at the other end of town. If that wasn't bad enough, I had to attend four more events during the course of the day.

I sat down on my Apple Mac, quickly copied all images on my camera's compact flash card to it, and left before people could find even more work for me to do. The details of the rest of that day are unimportant, but some time during the day, I changed cards in the camera. Worried about running out of memory mid-shoot, I decided to delete some of the pictures that I was "sure" I had transferred to my Mac. I started browsing through the photographs already on the card, using my camera's LCD—these things should be made bigger!

I spotted a folder full of images from a press conference that I had covered two days ago. "Delete? Are you sure? Of course I'm sure! What kind of question is that? Ahh, there, so much more space. But wait, why can I still see the same folder with all the same images?"

It was then I realised that I had deleted the folder of images that I had just clicked in the morning, which also happened to be the most important event of the day. Just before I could tear my hair out, I remembered that one of the geeks at office was telling me about some recovery software that could recover files from flash media. I decided to follow His Geekiness' advice to the letter,
and perhaps I could come out of this looking like less of a fool. Here’s what he had told me:

1. You really should try not to delete files, even accidentally. And if you must, double- and triple-check the files you are deleting to make sure you don’t get into a situation like this.

2. After backing up your photographs, delete the ones you have to by selecting them from your computer, in Windows Explorer, for example. This will give you a proper view of the images, unlike when using the camera’s LCD display. It is also easier to make sure which folder is selected when pressing delete—when in the camera menu, icons are so tiny and previews so unclear that it’s easy to make a mistake.

3. What’s done is done, don’t inflict further damage by writing any more data to the camera or card. Immediately remove the card from the camera, and use a card reader and software later to recover the files.

So I did just that. The next day at work, I rushed to the Test Centre and begged for help. After the initial guffaws and sniggers and the “Oh she’s so dumb” looks, someone decided to put me out of my misery. The card was put into a card reader, which was then hooked to a free USB port. As with everything, we hit Google for answers.

Zero Assumption was not able to find any files on our Compact Flash card, and it took forever to scan the card before it told us that!
for the term “image recovery compact Flash card”. We ended up downloading two software—Image Recall 3 and Zero Assumption Digital Image Recovery.

Zero Assumption was free, so we tried it first. It took forever, it scanned the card, and finally, told us that there were no files to be recovered. Very irritated, we tried Image Recall 3, and it found 255 images. Success!

Then the bad news, it only recovers the first 10 images it finds—it will recover the rest providing you register and pay the 30 odd pounds for the full version. Luckily the first 10 were the main images that I needed, so I made-do with that.

A few days later, I met a photographer who told me that he absolutely swears by Image Recall, especially since he finds himself deleting the wrong files about once every week. He took my card, and the next day I had all the deleted images from it on a CD. Impressed, I’ve decided to buy Image Recall 3 myself; when a software is good, it’s good, and worth every penny you pay for it!

Image Recall 3 did a great job of recovering photographs that I had deleted
Camera Care

Like any other piece of electronic equipment, your digital camera is precious and should be taken care of. Leaving it out in the dust or sunlight for too long can adversely affect the performance and make-up of the camera. Here are some tips to help you take care of your camera.

**Keep Your Camera In A Camera Bag**
An inexpensive camera bag is all you need to protect your camera from dirt, dust, and those unforeseen falls. But it would be worth the price of the camera (literally) if you invested in a quality bag that protected it from the elements. After all, you don’t want to be left stranded after an arduous hike only to find that your camera isn’t working...

**Keep It Clean**
Clean the outside of your camera by wiping it with a clean, dry cloth or soft camel’s hair brush. Never use harsh or abrasive cleaners or organic solvents on your camera or any of its parts. These tend to react with the body and can leave permanent scars in addition to hurting the circuitry. Also, avoid contact with oily substances such as any type of lotion. If your camera has a LCD (liquid crystal display), breath on it gently to create some moisture, then wipe it with a soft, lint-free cloth or untreated photographic lens tissue.

**Keep It Dry**
Most cameras are not waterproof. If your camera has been subjected to bad weather or you suspect water has gotten inside it, turn off the camera and remove the batteries and memory card. Let the camera air dry for 24 hours. If it doesn’t work, contact your camera’s manufacturer or an authorised service centre.
Purchase A One-time-use Camera
We know this defeats the entire purpose of having a digital camera, but sometimes, the best way to care for your camera is by not using it! If you’re going to be taking pictures in a situation where you’re worried about damaging your camera, a one-time-use camera is a smart alternative. There are many different kinds, so one is sure to meet your needs. Or, you could also take your old film camera along and save your precious digicam.

Long-term Storage
If you’re not going to use your camera for a while, remove the batteries. You don’t want them to leak in the camera. Be sure to store your camera in its camera bag in a cool, dry place. Moisture and drastic changes of weather can be the camera’s worst enemies.
Battery Care

General Tips
The following are a few simple rules to avoid driving your batteries beyond their normal exhaust point and worse yet, possible leakage.

- Replace all batteries at the same time.
- Do not mix new batteries with used ones.
- Do not mix rechargeable and non-chargeable batteries.
- Do not mix alkaline, nickel-metal hydride (Ni-MH), or nickel-cadmium (Ni-Cd) types of batteries.
- Do not mix different grades or brands of batteries.
- Do not attempt to rejuvenate a battery by heating it.
- Do not recharge any battery that is not marked “rechargeable”.
- In cold weather, keep your camera warm (not hot, just warm).
- Turn off your camera when not in use.
- Limit use of your LCD, which quickly drains batteries.
- Occasionally, clean the battery compartment components with a clean pencil eraser.
- Store batteries in a cool, dry place out of the reach of children.
- If you won’t be using your camera for an extended time, remove the batteries.
- Avoid high-temperature storage.
- Batteries can be stored at low temperatures (e.g. your refrigerator) to slow the discharge rate.
- Protect batteries from condensation by storing them in a zipped plastic bag.
- Allow batteries to reach room temperature before inserting them into your camera (cold temperatures impair their performance).

Battery Choices
Not all batteries are created equal. Battery life depends significantly on age, usage conditions, type, brand, and camera. Digital cameras are very demanding—not all batteries perform well in digital cameras. In some lab tests, nickel-metal hydride
(Ni-MH) rechargeable batteries delivered the best results in a variety of conditions. Ni-MH batteries are designed for high-demand devices, like digital cameras, and do not exhibit the “memory” effects seen with other rechargeable technologies.

Among non-rechargeable batteries, look for batteries that are intended for use in cameras, which unlike radios or flashlights, require short bursts of high energy. Lithium batteries perform extremely well in cameras, as well as “photo-flash grade” alkaline batteries.

You could save yourself a lot of trouble by choosing a camera that comes with a Lithium Ion (or Lithium Polymer) battery. These batteries retain their charge for long periods and are ideally suited for photography. More importantly, they have a good life span and come with their own charger saving you the additional expense on batteries.
Storage Options

Older models of cameras have inbuilt fixed storage, which can’t be modified easily—this inhibits the number of photos you can click before erasing them to make space for new ones. Most modern digicams use flash memory cards, small hard disks, CDs and sometimes even floppy disks.

The number of images that you can store in a digicam depends on storage capacity of the device (in MB), resolution at which the photographs are clicked, amount of compression used to reduce the file size.

Flash Card Storage
Flash memory chips (similar to the RAM chips used inside our PCs) don’t require batteries, take up very little space and can retain photographs indefinitely without any power supply to the flash memory components. These chips are packaged inside a special case, which is equipped with electrical connectors. However, memory chips come in a variety of formats, which are specific to certain camera models. The different formats currently available in the market are PC Cards, CompactFlash, SmartMedia, MemorySticks and x-Picture Cards.

Hard Disk Storage
Devices like IBM’s Microdrive hard disk drives help store outputs from high resolution cameras. Some of these drives can also be plugged into a Type II CompactFlash slot on a digicam or flash card.
Tips & Tricks

reader. Although first used in professional cameras, plummeting costs have seen widespread usage in ordinary cameras as well.

Optical Disc (CD) Storage
You can also use CDs to store picture albums, which can be shared with relatives and friends without any danger of corrupting the media—unless someone sits on the CD, that is.

You could also consider portable digital image storage and viewing device (notebook computers, for example) or portable hard drives like FlashTrax from SmartDisk, a multimedia storage/viewer device.

To store images, insert the memory card into a slot (using an adapter) and transfer your images. The speed with which you can make this transfer depends on the connections supported by the device (USB 2 or FireWire, for example)

Key points to consider when you are thinking about storage: Its capacity and cost per MB of storage, the formats it supports, transfer rate, whether it can display images on a TV set or be connected directly to a printer.
As we have mentioned before, there is more to photography than can be filled in one book or on one website. The best way to keep learning is to visit some of the Web sites mentioned regularly and invest in some of the books we are recommending. After all, learning never stops... Also in this section, you will find a huge list of software for viewing, editing, sharing, organising and doing what you please with images.

With digital photography expanding beyond capturing images, it is natural that peripherals form an important part of the digital photographer’s kit.

This section presents some such tools in the form of books, Web sites and software. While the list could have been longer, we have kept it down to the easy-to-use ones. There is, of course, much more available depending on what you are looking for and what is listed here is merely an indication of that.
Digital Photography Pocket Guide  
(Second Edition)

Author: Derrick Story  
Publisher: O’Reilly Digital Studio

Synopsis

Today’s digital cameras are affordable and provide quality images that rival their traditional film counterparts. Because digital images are easier to share, and because you only have to print the pictures you need, this new medium is both cost effective and environmentally friendly. Best of all, it’s fun! With a digital camera, you can set free your creative spirit and take risks you never would with a film camera. The only obstacle is learning how to unlock all this power and pleasure packed into these pocket-sized picture takers. Digital Photography Pocket Guide, 2nd Edition expands on the basic photography techniques introduced in the bestselling first edition to help you take the kind of pictures you’ve always wanted to—and now in full colour! This book is the photo mentor you’ve always wanted: it explains each of the camera’s components, shows you what they do, and then helps you choose the right settings. When you ask, “How can I get that picture?”, simply pull this small guide out of your camera bag, backpack, or back pocket and find the answer quickly. This fully illustrated book covers everything from image resolution, shooting sports action, close ups and night shots, to memory cards, transferring images, archiving, making QuickTime movies, and much more. Topics in the guide’s three main sections on “Digital Camera Components”, “Standard Camera Functions”, and “How Do I?” are labelled A to Z for quick reference. Or if you prefer, use the comprehensive index or table of contents to find the information you need. There’s even an entire section of easy to read reference tables for quick look up of white balance settings, exposure compensation, camera mode explanations, and much more.
Digital Photography All-in-one Desk Reference for Dummies

Author: David D Busch Publisher: For Dummies

Synopsis

Digital Photography All-in-One Desk Reference For Dummies is the perfect companion for the person who has confidence using a computer and navigating the operating system and at least some familiarity with their own digital camera. Acquaintance with an image editor, such as Paint Shop Pro, Corel Photo-Paint, or Adobe’s Photoshop or Photoshop Elements, is also helpful. Expect to get the goods on the—essentials of quality digital photography.
Digital Photography Made Easy

Author: Don Lindich
Publisher: Penton Overseas

Synopsis
If you’re a novice to digital photography, it has everything you’ll need to know for a good long time, without overwhelming you with too much information. And if you do get stuck, you can email the author and ask him for further explanation—at no cost!

How to Do Everything with Digital Photography

Author: Dave Huss
Publisher: McGraw-Hill Osborne Media

Synopsis
Avoid the time-consuming task of image editing by taking great pictures from the get-go. Dave Huss walks you through the fundamentals of taking great digital photographs by dispelling digital photography myths and teaching you how to maximise all camera features available to you. Discover how to take clear, sharp, professional-level photographs every time; use light wisely; use flash photography to your advantage; match your camera to your computer; share your photos, and much more.
Digital Photography: An Introduction

Author: Tom Ang Publisher: DK Publishing

Synopsis
From improving casual snapshots to learning the secrets of lighting, composition, and digital image manipulation, Digital Photography provides a practical, easily accessible approach to producing better digital photographs. With over 400 photographs, this concise guide shows you, as well as tells you what to do. The book also includes information on the most up-to-date equipment, software, and accessories, and professional hints and advice to help you get the most out of your digital camera.

The Photoshop Book for Digital Photographers

Author: Scott Kelby Publisher: New Riders Press

Synopsis
Written by Photoshop User magazine’s editor and bestselling author Scott Kelby, this book starts at the moment your digital camera photos come into Photoshop, and he shows you the Photoshop pros techniques for managing, correcting, retouching and outputting your photos to knock your client’s socks off, and turn you into a Photoshop production wizard. This book is ideal for traditional photographers who are making the jump to digital photography, and Scott’s casual, step-by-step, plain-English style makes even the most complex Photoshop techniques seem easy.

The entire book is graphically rich, in full colour cover-to-cover, and packed with real-world project-based tutorials that will take
you through the process of sizing your images with the proper res-
olution, how to deal with High ISO noise, blue channel noise, and
other common plagues introduced by digital cameras; colour cor-
rect photos for output on everything from inkjet printers to print-
ing presses. You will learn the sharpening techniques top digital
photographers use, and how leading re-touchers perform “digital
plastic surgery” in Photoshop, learn new tools such as digital
dodging and burning, troubleshooting, making client presenta-
tions within Photoshop and on the Web, and inside tips on how to
work faster and more efficiently than you ever thought possible. If
you’re serious about digital photography and Photoshop, this is
book you’ve been waiting for.

Digital Photography: Expert Techniques

Author: Ken Milburn  Publisher: O’Reilly Digital Studio

Synopsis
Serious photographers, including profes-
sionals, who want to take advantage
of the unique creative powers available
through digital photography and digi-
tal image processing, including
Photoshop CS, will find this problem-
solving book invaluable. Rather than a
general discussion of photography prin-
ciples, Digital Photography: Expert
Techniques focuses on workflow: time-
tested, step-by-step procedures based on hard-nosed experience by
and for genuine practitioners of the art.

Digital Photography Hacks
100 Industrial-Strength Tips & Tools

Author: Derrick Story  Publisher: O’Reilly Digital Studio

Synopsis
Going beyond the standard fare of most digital photography
books, Digital Photography Hacks shares the knowledge that pro-
Professional photographers have learned through thousands of shots’ worth of experience and years of experimentation. With exquisite, full-colour photos throughout, the book presents 100 proven techniques in the areas of daytime and night time photo secrets, flash magic, digital camera attachments, fun photo projects, camera phone tricks, and more. This book is your passport to taking the kind of digital photos you’ve always aspired to.

50 Fast Digital Photo Techniques

Author: Chris Maher, Larry Berman and Gregory Georges
Publisher: Wiley

Synopsis

50 Fast Digital Photo Techniques is an immensely useful book for anyone wanting to take advantage of photo-quality printers, digital cameras, Web technologies, Adobe’s Photoshop, and other top photo editing apps. The techniques are valuable to those with artistic skills as well as those without they enable everyone to enjoy successful creation of fine art images and prints! The step-by-step and richly illustrated collection of awesome techniques is easily accessible and understandable to users on every level. This is a new kind of Photoshop book one that can help both casual users and professional users create and enjoy fine art prints without having to become an expert in Photoshop.
Real World Digital Photography

Author: Deke McClelland, Katrin Eismann
Publisher: Peachpit Press

Synopsis
The title of Real World Digital Photography doesn’t adequately indicate the scope and sheer practical usefulness of the information within. Whether you plan to use digital imagery for fine art, illustration, or documentation—in print or on the Web—Real World Digital Photography is your industrial-strength reference guide to this exciting and evolving technology.

Written by two recognised experts in digital imaging, the book is full of hands-on production techniques designed specifically for working professionals. It also includes advice on how to choose a camera that fits your needs and your budget, a full-colour portfolio that beautifully illustrates the creative potential of digital photography, and the accumulated wisdom of artists who use the technology in their daily work.

Digital Photography Special Effects

Author: Michael Freeman
Publisher: Amphoto Books

Synopsis
By beginning with the basics of hardware and software, moving through techniques, and concluding with advanced applications, Freeman has created a valuable resource showing step-by-step what can be done with a digital image. The table of contents acts as an outline enabling readers to navigate to a needed area quickly. The material is arranged in spreads, with the discussion on the
left and the fantastic, colourful visuals on the right. The images are large enough for readers to see the software options. This book will challenge beginners and inspire students already manipulating digital images.

Silver Pixels: An Introduction to the Digital Darkroom

Author: Tom Ang
Publisher: Amphoto Books

Synopsis
This exciting book takes the reader through the latest camera technologies. Using brilliant photographs and clear explanations, Silver Pixels compares conventional and digital photography, showing the new world of effects that can be as subtle or extreme as desired, produced in black-and-white or in colour. Technical sections cover equipment, the central component of resolution, colour reproduction, output to print, and scanners. An extensive glossary and relevant tips on the World Wide Web are also included.
Creative Digital Photography

Author: Michael Busselle  Publisher: Watson-Guptill Publications

Synopsis
Digital photography has opened up image-making to a whole new audience, encompassing everyone from traditional photographers to budding computer enthusiasts. Covering more than 50 separate topics, Creative Digital Photography first demonstrates simple manipulations such as removing minor flaws or tidying up a fussy background. Readers then progress step by step into more complicated techniques like filter effects, layering, and montages—combining elements from a variety of sources into a new, original work of art. The most important message throughout Creative Digital Photography, however, is that computer wizardry is simply a means to an end: the emphasis here is to create memorable images rather than concentrate on digital gimmickry. Beautifully illustrated with over 150 full-colour photos and written with a minimum of jargon, this is an inspiring and informative guide for anyone interested in creative image-making.

40 Digital Photo Retouching Techniques

Author: Zack Lee, Youngjin.Com  Publisher: Youngjin.com

Synopsis
This dazzling, full-colour book provides a fun, practical introduction to photo-editing with Photoshop Elements. Are you new to digital photography and image editing software? Discover 40 valuable techniques and hundreds of creativity-inspiring images, plus
a CD filled with images for practice and a tryout version of Photoshop Elements 2, all at an exceptional price. You will learn to use the File Browser, change image size, enhance faces, fix blurry images, correct under- and overexposed images, turn photos from colour to black-and-white, remove people and objects from photos, add special effects, and much more. It is brought to you by Sybex and Youngjin.com, a leading South Korean book publisher known for brilliant graphics and digital photography books.

40 Digital Photography Techniques

Author: John Kim, Youngjin.com Publisher: Youngjin.com

Digital photography has truly reached the masses. Digicams are more affordable, full-featured, and fun than ever, and a huge market of new users is eager to explore this new medium. With this friendly, full-colour books, new digital camera owners can immediately start having fun with their digital cameras. It provides dozens of techniques for taking better pictures and getting creative with digital photography. The CD contains all the images used in the book’s examples, and additional images for practice and fun.
Shooting Digital: Pro Tips for Taking Great Pictures with Your Digital Camera

Author: Mikkel Aaland Publisher: Sybex Inc

Synopsis
Shooting Digital is a unique, full-colour guide to the art and craft of taking great pictures with your digital camera. With his exceptionally personable style, acclaimed author and professional photographer Mikkel Aaland shows beginning and intermediate photographers how to improve their shots, while helping more experienced photographers make the transition from traditional cameras to digital. Throughout, he gives techniques for taking great pictures with digital cameras, using step-by-step examples and case studies contributed by a team of professional photographers. These are complemented by stunning images that will inspire readers to take their digital photos to the next level.

Topics include-bridging the gap between film and digital; choosing the right digital camera; taking great portraits; photographing groups and social events; secrets of good travel photography; getting great action shots; shooting architecture and interiors; making beautiful landscapes; shooting merchandise; organising and sharing digital photos; and more.
Shoot Like a Pro!
Digital Photography Techniques

Author: Julie Adair King  Publisher: McGraw-Hill Osborne Media

Synopsis
Take your digital photography to the next level with help from this wonderfully written guidebook. Bestselling author Julie Adair King shows you the secrets that professional photographers use to capture memorable portraits, spectacular nature and travel images, and eye-catching product shots. Produce the kind of images that would otherwise demand a professional photographer or darkroom—or both.

Through a series of tutorial projects, author Julie Adair King shows readers how to light shots, choose the right camera settings, use camera accessories and photographic software, and much more. You’ll learn to use your existing digital camera for professional results. Set up a home studio, create a 360-degree panoramic image, learn low light and action photography, work in black and white, and adopt many other professional techniques.
202 Digital Photography Solutions: Solve Any Digital Camera Problem in 10 Minutes or Less

Author: George H. Wallace, Chuck Gloman
Publisher: McGraw-Hill/TAB Electronics

Synopsis
202 Digital Photography Solutions is for the hobbyist or pro who isn’t necessarily interested in reading a book, but is very interested in getting all they can out of their camera. Using 2-5 page solutions organized by function (composing a shot, digital editing of images) and deals in expert’s tips & tricks for every aspect of digital photography—from purchasing the best equipment for your needs to composing with a digital camera (knowing what kinds of clean-up or enhancement can be later done digitally) to creatively using digital special effects to create highly personalized images. This guide provides tips and tricks for every phase of digital photography. Covers how to compose perfect shots; correct poor colour, lighting, and red-eye; use special effects to create your own style; and more. 202... is guaranteed to help you make the most out of your digital camera.

National Geographic Photography Field Guide: People and Portraits

Author: Robert Caputo

Synopsis
Unlike most digital photography books, this guidebook does not go into the technical details of a digital camera. Instead, it focuses on taking the best pictures. How do you “freeze” your child in
action on the soccer field? People & Portraits, the second in the new, information-packed National Geographic Photography Field Guide series, supplies the answer to this question and much more as readers discover the secrets that have made National Geographic photography so well known.

People & Portraits reveals the best angles, lighting, and lenses to capture candid photos and portraits of family, friends, and everyone else. How to evoke a subject’s true character on film, how to compose a formal family portrait—everything the reader needs to know about photographing people is in this book. Filled with easy-to-understand instructions from an accomplished National Geographic photographer, this guide will be accompanied by specialized volumes on wildlife, black and white, digital, adventure photography and more.

How To Do Everything with Your Digital Camera

Author: Dave Johnson
Publisher: Osborne/McGraw-Hill

Synopsis

Do more with your digital camera than you ever thought possible with help from this easy-to-use guide. Although the title is a little overstated, this book does offer a fairly comprehensive introduction to digital photography. Johnson opens by discussing virtually all of the technical essentials of working with one’s
camera to make correct exposures and then proceeds to address questions about working with digital film and formats and transferring files. He further explains how to compose and edit photographs on one’s computer, showing how to improve sharpness and contrast, clean up images, use special effects, and blend text with images. The book concludes with helpful chapters on printing one’s photographs and sharing images through e-mail, web pages, and disks. Anyone who works with digital photographs will find this book quite thorough and useful. This book dissects digital photography in minute, understandable sections that will help anyone—from beginner to professional—have a better digital camera experience.

Digital Photography Bible

Author: Ken Milburn Publisher: John Wiley & Sons

Synopsis
Author Ken Milburn shares his experience as a photographer, with tips and tricks on how to take a good image, whether it’s the basics of high-quality photography or technical insights into working a digital camera—such as compensating for shutter lag or the usually excessive depth of field.

Packed with savvy tips, tricks, and techniques as well as up-to-date coverage of digital cameras, scanners, and image-processing software, this comprehensive guide shows you how to make the most of digital photography, whether you are a professional photographer, serious amateur, or graphic artist.
Complete Digital Photography

Author: Ben Long Publisher: Charles River Media

Synopsis
Intended both for amateur photographers and for traditional film photographers who wish to understand the new technology, this manual explains how to produce high quality digital photographs. Covers basic technological concepts, basic photography, choosing equipment, building a work station, shooting, exposure, preparing images for editing, colour and tone correction, special effects, and other topics. CD-ROM includes images used in tutorials, built around Adobe Photoshop, along with Mac and Windows demo Photoshop versions.

Digital Photography Manual

Author: Philip Andrews Publisher: Carlton Books

Synopsis
This fully revised and updated second edition of The Digital Photography Manual provides a complete and accessible overview of the digital photography process, the equipment and software used and the techniques employed. Step-by-step guides coupled with examples of images and screen shots carefully and supportively build the reader’s basic shooting (input), processing (manipulation) and printing (output) skills.
Rick Sammon’s Complete Guide to Digital Photography

107 Lessons on Taking, Making, Editing, Storing, Printing, and Sharing Better Digital Images

Author: Rick Sammon Publisher: W W Norton & Company

Synopsis
Through this book, Rick Sammon, one of North America’s most widely read photo columnists, covers all the steps in the digital photographic process. Sammon begins with basic advice for those new to photography. Experienced film shooters will enjoy Sammon’s ample coverage of Photoshop and digital image techniques. And in a bonus section, Sammon offers advanced tips such as taking glamour shots, producing e-books, and setting up a home studio.

The guide contains over 1,000 images teach shooting and Photoshop techniques in easy lessons for anyone wanting expert advice on digital photography. Sammon answers questions such as “How do I select a digital camera? How do I store my images? What are the first things I should do when using Photoshop?”

His approach of “learning to see and seeing to learn” uses pairs of
images, software screen shots, and the best photographs from his own vast library. The 107 lessons take the reader through each topic in friendly, concise steps. Also included is a CD-ROM with “The Camera Looks Both Ways,” a mini-course in photography.

Digital Photography: Top 100 Simplified Tips & Tricks

**Author:** Gregory Georges

**Synopsis**

For those who would like to go beyond, with shortcuts, tricks, and tips that let you work smarter and faster. Inside, there are clear, illustrated instructions for 100 tasks that reveal cool secrets, teach timesaving tricks, and explain great tips guaranteed to make you a better digital photographer.
15 Great Web sites On Digital Photography

DPReview.com: The grand-daddy of all sites on digital photography. This site has been around for ever and ever, and yet manages to retain its super-professional outlook towards digital photography. The hallmark of this site is its detail, with practically every aspect of the camera being looked into.

DPChallenge.com: Every week, this Web site throws several challenges at photographers—amateur and professional. For a small fee of Rs 90 a month, you can take part in all contests that are run the site, and win some really cool prizes. Besides, you can also store your portfolio on the site (with a limit of 10 MB), sell your prints, the works.
Shortcourses.com: It may look like an amateur site with text links strewn all over the place, but never ever judge a Web site by its appearance. There are online courses (most of them free) that help you do everything from choosing a digital camera to editing pictures to just about everything related to digital photography.

Megapixel.net: A magazine on digital imaging on the Internet that has new cameras being reviewed every week. Readers can also participate in online discussion forums on specific topics. There is also a free classifieds sub-section where users can sell their digital cameras.

Howstuffworks.com/digital-camera.htm: Everything you ever wanted to know about digital cameras from the guys who tell you everything about everything.
PCPhotoreview.com: Right from news items on digital photography to sneak peeks on new models to a review of the day to complete advice for both amateurs and prosumers, this site has just about everything you want to know about digital photography. With more than 10 full-fledged learning links, this site is a must-go.

Cnet.com: Probably the ultimate technology Web site there ever was. Click on the digital photography link and discover the wealth of data available on digital photography. Cnet undoubtedly has one of the best testing labs in the world, and technology users worldwide go by Cnet’s credibility. From choosing digital cameras to comparing them with similar models to buying them at a discount to tips and tricks, this site is a one-stop shop for all things technological.

Livingroom.com.au/photolog: You want an independent top-class blog on digital photography. Here’s one that you need to make a habit of reading. This has the latest news and reviews of the latest digital cameras, besides some really informative tutorials on creating great digital photos.

Snapclub.com: So, you are an amateur, and have a low-end to mid-end digital camera? How about displaying some of your best works online to your peers and the rest of the world. Snapclub lets you watch and share great pictures shot on your digital camera.
Dpfwiw.com: Strange URL, stranger name. Digital Photography For What It's Worth is a simple looking Web site with some really cool articles on digital photography gleaned from various sources around the world.

Best-digital-photos.com: A no-nonsense Web site that offers common sense photography tips to get the best out of your digital camera. Plus you can buy cameras, enhance your photos for free, read the camera blog, read reviews of related software, the works.

Outbackphoto.com: Talk about going niche. Outbackphoto is dedicated to outdoor photography. The only hitch is that it concentrates mainly on professional photographers, and talks in their language. For beginners, this place is only when you want to study how professionals work, and what differentiates them from the rest.

Dcreresource.com: A well-designed, easy-to-navigate Web site on digital photography hosted by a photographer whose seeming mission in life is to educate the world about photography and just about everything related to it.
Dcviews.com: A funky looking Web site that gives everything from news and reviews to cool tools and sample photographs. Don't miss out the Hotshot of the Day, a picture of the day announcement on the home page.
Imaging-resource.com: Rated as one of the best Web sites related to digital photography, this one, like DPReview.com is a one-stop shop for everything related to digital photography. News, reviews of almost every model available, brand-specific forums, newsletters, online tutorials and how-tos, etc dominate the site. A pleasant look enhances the browsing experience.
Imaging Software

3D Stereo Image Factory PLUS
Create your own exciting Stereoscopic Images on your PC using your very own stereo image pairs with this amazing software. Accepted throughout the world as the application for stereo imaging on the PC. With its intuitive and easy to use interface anyone can create true stereoscopic images in just a few simple steps.

Web site: http://members.aol.com/threedr/

602Pro PC Suite
Free alternative to MS Office that’s compatible with Word and Excel files, integration with Outlook Express, digital camera and scanner support is included. The add-on Plus Pack lets you create interactive photo albums, organize your images with 602Desk, print Bar Codes, export your documents into an easy-to-use JPEG web presentation and more.

Web site: http://www.software602.com/products/

ACDSee
ACDSee is the fastest picture viewer, graphic converter and image-sharing tool available for Windows. ACDSee gives sharp image tools, batch file functions, and plug-in features so you can enhance, convert, and share your images over the Internet instantly. You also get faster TIFF and JPEG image viewing and thumbnail browsing. It’s the preferred graphics software for image processing, digital cameras support and photo services, amongst both amateurs and professionals.

Web Site: http://www.acdsystems.com

Active Desktop Wallpaper
When it comes to desktop wallpaper, you usually have a favourite picture acting or simply stay with sterile background colour. This software could breathe a bit of life into that! Active Desktop Wallpaper helps you to use desktop wallpaper in a completely new
and creative way. If you already have a collection of pictures in jpg or bmp formats, you can create a whole bunch of different wallpapers in just a couple of quick steps. Simply use those pictures as building blocks for making wallpapers. Furthermore, you can enrich your creation with text messages of different sizes and styles. Once you have made a collection of different wallpapers, Active Desktop Wallpaper has three working modes that will transform any desktop to an effective picture gallery.

**Web site:** http://www.xemico.com

**Adobe ActiveShare**
Organise, enhance, and share your digital photos with family and friends. Imports photos from digital cameras, scanners, or Kodak Picture CDs and lets you view them on your desktop. Enhance your photos and organise them into digital photo albums. Let’s you order prints online, create personalised postcards that are mailed for you or post your photos to a Web community.

**Web site:** http://www.activeshare.com/

**Adobe Photoshop**
Adobe Photoshop has always been on the forefront of image editing. Delivering the broadest and most productive toolset available, Photoshop helps you explore your creativity, work at peak efficiency, and achieve the highest quality results across all media.

**Web site:** http://www.adobe.com/

**Aliu’s Magic Lantern**
With the workbench program, you can store your pictures into virtual slide trays. You can record the date each picture was taken, along with a short description; you may also attach a sound file or a music file to your pictures.
These trays are usually stored on your hard disk, but you can copy them on a CD too. You can view pictures by dropping the slide trays icons over the projector program.

Web site: http://www.reseau.org/aml/

AutoEye
Auto FX Software’s AutoEye is a product that was created to automatically improve digital images by rebuilding colour detail, sharpness and image vibrancy. AutoEye uses a different set of adjustment methods than Photoshop or other image editing applications. AutoEye does not use standard curves and histograms to adjust images on a global basis within the RGB or CMYK colour space. As such, AutoEye’s unique methods often result in image enhancements that are easier to attain and yield a higher quality result.

Web site: http://www.autofx.com/

AutoRun SlideShow
Most digital cameras come with a slideshow program, which works when viewing photos and videos on your PC but how are you supposed to send photos and videos to friends and family and have them view a slide show? SlideShow is a small program that you can put on a CD and the user can view the slideshow without having to install a player. This allows you to create self-contained slide shows on diskette, zip disk, or CD.

Web site: http://www.duckware.com/

Calendar Builder
This software lets you illustrate calendars with your digital images. When you purchase Calendar Builder, you get over 700 additional icons for animals and birds, arrows, books, cameras, clothing,
drawing, earth, eyes, food, holiday and party, insects, money, music, notebooks, phones, plants, reminders, reptiles and amphibians, showbiz, smiles, spheres, sports and recreation, symbols, and time apart from a range of borders in 3D, Abstract, Celtic, Checkers, Floral, Lines, Ornate, Southwest, Stars, Triangles, and other styles.

Web site: http://www.rkssoftware.com

**CompuPic Pro**


Web site: http://www.photodex.com/

**Cumulus**

Cumulus 5 is the perfect archiving system for multimedia data (aka media assets or digital assets). The Cumulus 5 platform also offers a flexible base for any kind of workflow solution for assets in production. Cumulus is a high-end application for
managing and publishing all types of media assets such as images, layouts, presentations, video, audio and text. The program offers powerful search capabilities, comprehensive customizing options, e.g. user-definable fields, and Internet access, incl. HTML export, e-mailing and more. When cataloging your digital assets Cumulus automatically reads the contained metadata, creates a thumbnail and references to the original data—no matter which storage media they are on.

Web site: http://www.canto.com/

**Do Neat Things With Your Stuff**

This program helps you enjoy and manage your collection of digital photos (and movies, music, Realmedia). Make, save and auto-play or manually play playlists with just a few keystrokes. Use your own keywords for your playitems and search for them. Organise your files into one or more databases and even password protect your confidential material. View thumbnails and “contact” sheets and clip, flip, rotate and magnify as well as add captions, descriptions, names and keywords. Put the same picture in an album more than once or in more than one album—each time it can look different.

Web site: http://www.doneatthingswithyourstuff.com

**DreamSuite**

DreamSuite provides you with photo-realistic results that are difficult or impossible to achieve using any other software or method. Auto FX will be releasing several series of DreamSuites. Series One is the first in this new product line. Series One features 18 visual effects.
Most of the effects in this series are brand new to the industry and unique in their digital forms. They include 35mm Frame, Chisel, Crackle, Crease, Cubism, Deckle, Dimension X, Focus, HotStamp Instamatic, LiquidMetal, MetalMixer PhotoBorder, PhotoDepth PhotoTone, Putty, Ripple, and Tape.

Web site: http://www.autofx.com

**DubIt**

DubIt is a multimedia tool which lets you easily add audio to movie clips and images. Unlike video editors and presentation authoring products, DubIt adds audio in real-time as you watch the movie or image. With DubIt, it is easy to narrate a video clip and synchronise your voice with the video. DubIt is the perfect tool to quickly add voice annotation and sound effects to a movie or image. DubIt uses a familiar VCR-style “Media Player” interface that anyone can use. There is no complicated setup or long learning curve with DubIt. Simply open a movie or image and hit the record button.

Web site: http://www.techsmith.com

**Easy Photo Album**

Easy Photo Album automatically creates cool-looking photo albums from your digital images. You can use the program to create Albums on your hard drive or very easy make CD photo albums. Later you can add a background music and record Sound Memo for any picture. The program is great for using with Direct CD burners as well. You can even create multiple albums or indexed albums just simple making a new subdirectory with additional images.

Web site: http://www.cdpeople.com/

**EZ Viewer**

View your pictures in a single file directory view, a MultiView template, or a window of thumbnails of images files in a folder. Edit and enhance your pictures in a variety of ways. You can rotate, resize, crop with aspect control, adjust contrast and
brightness with shadows, midtones, and highlights, RGB color control, B&W grayscale convert, red-eye reduce, air brush, blur, and sharpen. A clone tool to remove scratches and tears, fix blemishes, restore a photo, and add just plain fun effects. Pixel Fix dropouts from scans or oversharpened images. Batch process a selection of image files from a folder to batch crop, rotate, resize, file format convert, and file rename. Add colour borders or add numerous different special effects.

Web site: http://www.ezviewer.com/

**Family Picture Calendar**

Prints customised, professional quality, family oriented wall calendars. Automatic Birthday and Anniversary year counts. Background pictures: Save a different picture for each month of the year. Event pictures: Saved with any event then automatically placed in the empty date squares for that month. Auto Font Sizing: Re-sizes all fonts in a given date square to help eliminate overflow. Holiday files: Holiday events added automatically. True Print-Preview feature: Saves ink and paper. Save calendar as a picture file: Load into Word or use as wallpaper, etc.

Web site: http://www.famcal.com/

**FlipAlbum**

FlipAlbum is the world’s first software that automatically organizes digital images into realistic page-flipping picture albums. It has everything you need to organise your digital photos, make powerful presentations, even email your pictures. FlipAlbum’s book-like animated turning pages, makes it a natural and intuitive experience. It opens the window to a whole new way of organizing, editing, viewing and e-mailing digital images, photos and multimedia files.

FlipAlbum creates your picture albums instantly and automatically. You can organise all your digital pictures into albums according to any occasion or topic. Thumbnails of your pictures, table of contents and indexes are automatically generated to help you quickly locate your pictures. An advanced image editor
helps you to enhance your pictures and annotate your album pages, making your presentations even more spectacular.

**Web site:** http://www.ebooksys.com

**FlipAlbum CD Maker**

FlipAlbum CD Maker allows you to recreate the effects of FlipAlbum for your family and friends by saving your photo album digitally onto a CD. Share your personalised copy of those special moments with 3D-animated flipping pages and matching background music.

**Web site:** http://www.ebooksys.com

**FotoAlbum**

The free photo organiser for Windows includes features not found in program’s that cost much more. Interfaces directly with modern digital cameras and all Twain devices. Allows you to organize your pictures into albums and groups. Allows you to select and send the pictures you want on the web. You can also make some or all of your pictures private so that only select individuals can see them. Provides enhanced printing allowing you to print near photo quality with a variety of printers.

**Web site:** http://www.fototime.com

**FotoAngelo**

FotoAngelo is a flexible slide show and screen saver creator for making impressive presentations for family and friends, or colleagues and associates. Choose from 20+ photo transition effects and
select manual or automatic playback with this versatile multimedia builder. Select your favorite background colour, insert text and add music and sound effects to specific digital images to convey important information or set the right mood. Creates an exe file that can be played back from a CD without additional software.

Web site: http://www.acdsystems.com/

FotoCanvas
FotoCanvas is an easy-to-use photo editor that takes digital imaging to the next level. Improve your photos with tools like red-eye reduction, free-angle rotate, crop and sharpen and blur image filters. Express your creativity with fun and flexible drawing tools, selection tools, colour and light blending modes, and special effects filters like sepia and emboss. Plus, get a fast picture editor with a customisable interface and other features.

Web site: http://www.acdsystems.com/

FotoStation Pro
FotoStation Pro is an asset manager that lets you search among thousands of images, write IPTC (Photoshop compatible) text, acquire new images from different sources, enhance and correct colour, and much more. FotoStation Pro can be used as a stand-alone product, or connect it to an FotoWare Index Manager, and you can store millions of images. FotoStation Pro is the preferred tool among thousands of professional image users, and the leading position has made it almost an industry standard among newspapers in Europe.

Web site: http://www.fotoware.com

GIF Construction Set Professional
The state of the art in GIF animators, GIF Construction Set Professional features Animation Wizard to create sophisticated animations; Supercompressor to
squeeze your GIF files down to size; extensive documentation and tutorials; and much, much more.

Web site: http://www.mindworkshop.com

**Halftone**

The Halftone plug-in can transform your source images in a halftone dithering pattern. You've probably seen this effect before when looking at a newspaper where it is used for photographic images and for shading black & white cartoons and graphs. You can use the Halftone plug-in to accurately reproduce this effect and have full control over how it is applied. Halftone is a plug-in for PhotoShop compatible plug-in hosts. It will work with applications such as Adobe PhotoShop, JASC Paint Shop Pro, Corel PhotoPaint, ULead PhotoImpact and MicroGrafx Picture Publisher amongst many others.

Web site: http://www.v-d-l.com

**Image Puzzler**

You've seen them on movie posters, stores in the mall, and magazine covers—those cool works of art that create a picture from thousands of smaller images. Now you can make one too from a series of smaller images called tiles. These smaller images are selected and placed in the best possible position by a computer program such as Image Puzzler. The computer software evaluates each tile for shape, colour, texture, image content, and more before deciding where to place it in the overall picture.


**ImageFox**

ImageFox 2.0 lets you preview image, video and sound files while you browse in the Open/Save_as dialog box of most 32-bit Windows programs. Preview your files without opening them and without
having to launch an application for a specific file type. For example, you can preview image files in Windows Notepad™. ImageFox 2.0 also lets you create application specific and global favorites folders for your frequently previewed files. Plus, it lets you edit file descriptions that can be viewed in other applications. Image, video and sound file previews along with function shortcut buttons appear in the right or bottom area of the Open/Save_as dialog box according to your preference. ImageFox 2.0 supports over 40 image and multimedia file types and comes with online help files. It is compatible with Windows 2000 and Me, as well as earlier Windows versions.

Web site: http://www.acdsystems.com

**IrfanView**

IrfanView is a very fast freeware program for non-commercial use. It’s one of the first viewers with multiple (animated) GIF, multi-page TIFF, and multiple ICO support. Features include thumbnails, preview, drag & drop Support, fast directory view (fast moving through directories), print support, scan (TWAIN) support, slideshow, batch conversion, colour depth control, audio CD player, capturing, cut/crop, effects (blur, sharpen etc.) and many many more. The program requires only one EXE-File so it’s perfect for putting on image CDs you want to share with others because there is no software to install.

Web site: http://www.irfanview.com

**JigS@w Puzzle**

JigS@w Puzzle is a virtual jigsaw puzzle with great 3D appearance and smooth movements that emulate the real thing. JigS@w Puzzle allows you to create your own puzzles with your own images (BMP, JPG, TIF) and background music. During solving a puzzle you have some helpers at one’s disposal which make solving easier. If you complete the puzzle you can exhibit it in a 3D
gallary, where you can freely walk and take delight in your successes. You can also send puzzles to your friends directly from the game. The user interface is available in 27 languages!

Web site: http://www.tibosoftware.com/

**Jasc Paint Shop Pro**

Paint Shop Pro offers an easy and affordable way to achieve professional results. High-end professional products cost a fortune and take a lifetime to learn.

Web site: http://www.jasc.com

**LensDoc**

LensDoc corrects the barreling and pin-cushioning image distortions produced by many zoom and wide angle lenses. Identify two lines that should be straight and place the target points as guides. LensDoc does the rest.

Web site: http://www.andromeda.com

**Morpheus**

Morpheus is a freeware program that lets you morph from one image to another.

Web site: http://www.csis.gvsu.edu/~rubleyr/morpheus/

**Mugshots Games**

How would you and your kids like to put your faces in five great games? You can do just that with Mugshots Games for Windows. It’s easy to import your faces from digital cameras, scanners,
and JPEG or bitmap files. The games are so good they were awarded 5/5 by TuKids.com and A1Yippee.com, and come bundled with JVC digital cameras.

Web site: http://www.mugshotsgames.com/

**MyAlbum**
A free picture cataloger for building easily digital photo album. Supported picture formats JPEG, BMP, PNG, GIF, animated GIF, TIFF, TGA, PCX and WMF files and supported video formats AVI, MOV (QuickTime), MPEG. Poster printing on several sheets of paper and builds contact sheets and HTML pages.

Web site: http://quebec.eds-ingevision.fr/DMS/MyAlbum.html

**My Photo Slide Show**
My Photo Slide Show is an authoring tool for creating photographic slide shows to be displayed on Windows-based computers. It makes the managing of large photo collections a snap by allowing you to categorize the photos and quickly view thumbnail sized versions of the photos.

Web site: http://www.copseystrain.com/

**MySlideShow**
MySlideShow was specially designed for creating “autorunnable” CD slide shows. You can add captions, sound/music files, use transition effects. Also you can pack a generated slide show to a .zip file and send it by e-mail. The program creates simple web slide shows.

Web site: http://www.anixsoft.com/

**Multimedia Builder**
Develops multimedia apps, autorun menus or front-ends for your CD’s without having to spend months learning complex programming languages. If you are already developing software on CD-ROM, creating your own CD-Audio or making your MP3 CD you will love this easy-to-use, intuitive software. Create multimedia
applications with graphic, text, sounds, MP3, Video, supporting CD Audio or Mixed-mode CD’s, executing applications and much more... Apply many cool effects to your images. MMB creates small stand-alone exe applications and has all the bells & whistles you will ever need.

Web site: http://www.mediachance.com

OfotoNow
OfotoNow lets you edit and upload multiple photos to online albums at ofoto. The program lets you get photos from your camera or scanner to your PC, view your photos: zoom in or out within each photo, view all the images as thumbnails, view your images as a slideshow, make copies of the photos and save them to a different location. You can rotate your photo onscreen to make it appear right side up, trim out the parts you don’t want to print, and even fix the “red-eye” flash effect. OfotoNow is currently available for computers running the Microsoft Windows operating systems (Windows 95 and above) and for Macintosh computers (OS 8.6 and above).

Web site: http://www.ofoto.com/

Panorama Factory
The Panorama Factory is a panoramic stitching program. You can use it to create high-quality panoramas from a set of overlapping digital images from a single vantage point. The Panorama Factory seamlessly joins images into panoramas whose fields of view can
range up to 360 degrees. In fact, you can make panoramas that exceed 360 degrees if you wish!

Web site: http://www.smokycity.com

**Paper PhotoCube**

Paper PhotoCube lets you easily print photo cubes. Drag and drop six JPEG images onto the template, print it out, put it together, and proudly display it on your desktop or coffee table. You can also create a JPEG version of your cube to email to family and friends or publish on a Web site.

Web site: http://www.trivista.com

**PC PictureShow**

PC PictureShow is a picture viewing utility that displays your pictures all at once in the PictureIndex, or in an automatic PC PictureShow one after another. Pictures can be printed or be rotated for viewing in the correct orientation. PC PictureShow also allows you to convert and export the pictures into standard bitmap (BMP) or pict (PIC) image formats for use in other programs such as word processors, paintbrush, or image enhancement software, or into JPEG image format for transmission over online services such as the Internet. You can advance through the pictures forwards and backwards, add text notes, and copy pictures to the clipboard. Pictures can also be removed from PC PictureShow or zoomed to fill the screen. There is a user’s guide on-line at the Konica site.

Web site: http://www.konica.com/

**PhotoFrame**

Extensis PhotoFrame 2.0 gives you the edge—and there’s no limit to the dramatic border effects you can design for your images. Customise and combine any of the included 1000+ edge effects, or use Instant Frame and
Instant Edge to design your own frames. Go beyond the ordinary with special effects like shadows, glows, textures and bevels.

Web site: http://www.extensis.com

**PhotoELF**

PhotoELF helps you view, edit, print and organise your photos. If you are new to digital cameras and computers, you will like PhotoELF’s simple to use, open interface.

Web site: http://www.photoelf.com/

**Photo Explorer**

Photo Explorer 7.0 Pro combines easy-to-use tools for acquiring, viewing, organizing, adjusting and sharing digital images and video clips. The demo is a 30-day trial version.

Web site: http://www.ulead.com

**PhotoExpress**

Photo Express 4.0 comes in a My Scrapbook Edition for scrapbook lovers! Get your photos looking their best with easy-to-use enhancement tools. Then organise and sort photos fast with the handy Browse mode. Finish up by using a scrapbook-making kit filled with customisable templates and page accents to create unique pages.

Web site: http://www.ulead.com/pe/trial.htm

**PhotoFantasy**

PhotoFantasy 2.0 is a hilarious entertainment program that lets you place faces in a broad variety of fantasy backgrounds. Using the powerful masking tools, you can also make your own PhotoFantasy background templates using scanned images from magazine covers, ads, posters, calendars, tabloids and more. See yourself as an astronaut, a cover girl, or anything you want to be!

Photo/Graphic Edges

Auto FX Software’s Photo/Graphic Edges is a unique creative tool that makes your photos distinctive and artistic with the click of a button. PGE adds torn, ripped, deckled, feathered, painted, film frames and darkroom styled edges to any grayscale or colour image. Instead of having the same old boring square images in your designs, expand your options with more than 10,000 different creative effects using Photo/Graphic Edges 10,000+. The included samples will free the imagination and empower the creativity of professional designers and novices everywhere.

Web site: http://www.autofx.com/

PhotoPrinter

PhotoPrinter is an easy-to-use printing utility that enables you to lay out your favorite images in multiple sizes on a single sheet of paper, quickly and effortlessly. PhotoPrinter templates offer a wide selection of printing dimensions. You can use PhotoPrinter’s image-editing tools to enhance your photos before printing; and you can also add frames, edges and other backgrounds to each image in the template.


Photo-Sampler

Photo-Sampler is used to reduce the effects of noise in digital images. This noise, which appears as grain or blur in an image occurs when you use high ISO settings to photograph in dim light. To use the program, you shoot series of still images of the same subject. The program then processes the series of photos and analyzes each matching pixel in the sequence. By following the same pixel through a series of photos it can tell what is caused by random noise and what comes from the non-random subject.

Web site: http://www.holographic-tech.com
**Photo Studio**

Photo Studio is an image management tool. It supports everything from downloading the images from a camera, through lossless image rotation, comment editing, GPS info addition, thumbnail creation/extraction, right up to generating HTML index pages. Additionally Photo Studio is a useful tool for examining and manipulating the contents of additional data stored along with your images, supporting a wide range of formats from EXIF/DCF and CIFF (as saved by many digital cameras) through JFIF to the often used Photoshop extensions. Furthermore Photo Studio can be used to create mosaic images, tiling together your existing digital images, either at random, or to fit to some larger image.

**Web site:** http://www.stuffware.co.uk/

**PhotoStudio**

PhotoStudio is a powerful, full-featured, easy-to-use photo editing application. It provides a huge collection of photo editing and retouching tools, plus a large assortment of enhancements and special effects with unlimited levels of modification. A highly affordable package, the program also offers many other high-end features such as image management, multiple undo/redo, multiple layers, editable text, macros and batch-processing.

**Web site:** http://www.arcsoft.com/

**PhotoTile**

A Windows 95-98 NT shareware program for creating images that are composed of hundreds or more digital photos. Supply your own target image, and PhotoTile will replicate it by arranging the digital photos supplied by you, or using photos from the supplied image collections.

**Web site:** http://www.prismaticsoftware.com/

**PhotoVista**

Create immersive 360° Web panoramas! Photovista lets Web
designers build highly interactive Web sites that visitors can experience—not just look at. Create real estate, travel, art or entertainment Web sites, complete with zoomable 360º images, by turning a series of snapshots into a seamless panorama in minutes. Site visitors can interact with high-resolution, low bandwidth, panorama files—in real time and without a plug-in!

Web site: http://www.mgisoft.com/

**PhotoVista 3D Objects**

Photovista 3D Objects lets you quickly create detailed, photo-realistic, 3D image objects that site visitors can pick up and rotate at the click of a mouse. Great for online catalogs, product demonstrations and more!

Web site: http://www.mgisoft.com/

**Picasa 2.0**

No more filenames, folders, or directories. Just your pictures, organised by date, in a simple list. No more hunting around your computer, looking for that special picture, no more fiddling with settings to try to e-mail pictures to friends. One simple place to organise, enjoy, and share your pictures.

When you install the program, Picasa automatically finds and displays all photos in all directories on a computer’s hard disk, displays them in mini-albums and arranges them by date. It then presents each mini-album ready for viewing as a slideshow or in an “Timeline”.

Web site: http://www.picasa.net

**PICShow**

With PICShow you can create a slideshow to show your pictures with sound and text to completely describe the moment. PICShow is a simple easy to use slideshow creator with the ability to create a stand alone slide show that you could email or put on a disk. PICShow supports many standard file formats including BMP, PCX, DIB, KQP, JPEG, JFIF, DCX, TIFF, G3/G4, ePic, PNG, TGA, WPG, and
WMF. Show your friends, family and business associates a quick presentation, a special occasion, or a beautiful experience. Create a small executable player to send to someone so they can view the slideshow by just clicking on the executable file.

Web site: http://www.jpg.com/

**Picture Window**

Picture Window is a unique software package for photographers that turns your personal computer into an incredibly powerful electronic darkroom. It lets you bring your photographs into your computer, enhance them using powerful image editing tools, and then create high quality prints, multimedia slide shows, photo screen savers, and much more. Unlike many expensive image editing programs designed for professional graphic artists and illustrators, Picture Window was created expressly for serious amateur photographers who want more creative control over their images and for professional photographers who want to expand their business by offering digital image processing services at affordable prices. If you’re a photographer, you’ll find Picture Window uses familiar terms and techniques, and lets you do perspective correction, colour balancing, retouching, and tonal adjustments quickly and easily. The evaluation software will expire 30 days after the first time you run it (this trial period cannot be circumvented by downloading the software a second time).

Web site: www.dl-c.com

**PicturesToExe**

PicturesToExe creates presentation in stand-alone .EXE file. Using a clean-looking, intuitive interface, you select pictures from any combination of folders on your system. Then press the Create button. In just moments, you’ve produced an .exe file that, when run, displays the images with the options you’ve selected. Options let you specify automatic or manual sequencing, pick the timer interval, adjust font and background properties, and decide whether you want the sequence to run once and terminate or to repeat continuously. You can also add a MIDI, WAV or MP3-based soundtrack and associate each picture with a .wav file.
PicturesToExe is a nice way to share your favorite images with others in a compact, easy-to-email form.

Web site: http://www.wnsoft.com

PicViewer
PicViewer is an image viewer, file manager. It allows you to convert images to different formats, print them and their thumbnails, set wallpapers, rename a group of files, create simple slide shows, etc.

Web site: http://www.anixsoft.com/

PixMaker
Create 360° interactive object views, and PixAround Scenes and Web pages with Hotspots to other scenes, Web pages, audio or video files. You can print or publish your scenes to the PC, Web or even your PDA! The PixMaker 1.0 (Trial Version) on this disc does not allow you to Save, Publish, or Print. To enjoy these features, please purchase the Business Edition or Home Edition license from PixAshop. Some features offered in this trial version are not available in PixMaker 1.0 (Home Edition). Click here to see the full feature list.

Web site: http://www.pixaround.com

Portfolio Desktop Edition
It’s the visual catalog that’s easy to use. Portfolio 5 Desktop Edition helps you catalog and retrieve digital files, including photos, clip art, movie files, audio and more. Powerful previews, digital water-marking, customisable thumbnails and slideshows make it the fast and easy way to catalog digital files.

Web site: http://www.extensis.com

Qimage Pro
Qimage Pro is a digital imaging application that has grown from its simple roots of printing multiple images on a single page, to being one of the most frequently referred to and highly recommended digital image applications in the world. Qimage Pro is
designed to make image printing easy and painless by eliminating the need to resample images to higher resolutions, manually place images on printed pages, make touch-ups and apply filters in separate photo editors, etc. For a purchase price that is a mere fraction of the cost of high end photo editors, you get an application that is capable of producing professional quality prints that exceed the quality of nearly all other photo printing applications, even high end (read incredibly expensive) photo editors.

**Web site:** http://www.ddissoftware.com/qimage/

### RealSlideshow

Use it for either business or personal use—RealSlideshow Plus 2.0 delivers unmatched layout control, linking and graphic capabilities for creating dynamic RealAudio slide shows. You can add synchronised music and text captions, add hyperlinks to each image so viewers can click to go wherever you decide, and use a persistent image as either a logo for corporate identity or branding, or to provide a theme to a particular presentation. The program gives you full control of your layout. You can easily adjust the size of the presentation and control the location of the different elements within it.

**Web site:** http://www.realnetworks.com

### RGBLight

Professional photographers know that using an interesting light is the 80 per cent of success. Even photography gets its name from light. Now you can produce amazing close-up photography without using the expensive light equipment.

**Web site:** http://www.mediachance.com

### S-Spline

When enlarging images, S-Spline “looks” at them in an intelligent way, and tries to adapt its patented interpolation method from pixel to pixel, depending on how sharp or smooth the image is in that area. For smooth areas, the algorithm will perform much like B-Spline or Bicubic interpolation. For sharp areas it uses different
interpolation techniques and some mathematical tricks, trying to maintain the original sharpness of the image.

Web site: http://www.shortcut.nl/

**SlideShow Ultra Gold**

Slide show, presentation, screen saver software accepts pictures in all the popular formats. (jpg, gif, bmp, etc.) Plus you can add movie files (.avi, .mpg), include your favorite sound clips and music (wav, mid, rmi, mp3, CD Audio), add cool transitions and effects, text and more! It's fun and very easy to work with. Do something different with your pictures!

Web site: http://cmbsoftware.com

**Thumbs**

Thumbs is a program to generate thumbnails for the purpose of making a CD of images to send to a friend or relative and allow them to view the images without having any special software. It's also great for preparing your images for archiving/backing up as well as making thumbnails for displaying on web pages.

Web site: http://www.greggman.com/thumbs/

**Ulead GIF Animator 5**

Ulead GIF Animator 5 is the world’s most robust and affordable GIF animation tool, delivering industry-leading features for composition, editing, special effects, optimisation and output in a single package. The demo is a fully functional 15-day free trial version.

Home site: http://www.ulead.com

**Wright Photo**

Wright Photo is an easy to use all-in-one program for image manipulation, illustration and headline text, which makes an affordable and powerful asset in the toolkit of the photo enthusiast. From entry level to professional, Wright Photo is huge in performance. Real time image processing of extremely large files, a professional
retouch and compositing toolset and excellent text and drawing capabilities are just some of the features of Wright Photo. Wright Photo is object based with resolution independence, editable air brushing, comprehensive colour masking, extraordinary special effects, drag and drop colours and styles with multi-coloured gradient fills, editable bezier curves, multiple colour spaces, PostScript and Windows output and much more.

Web site: http://www.wrightna.com/

**ZDNet’s EasyNoter**

ZDNet’s EasyNoter is a personal information manager with some interesting extras. Its attractive, intuitive interface is reminiscent of a pocket planner notebook (such as a DayTimer). Use its tabbed pages to display photos, keep a diary, jot down notes, organize addresses, and set reminders. The Photo Album can display expandable thumbnail images and lets you add notes below each photo. Use the Skin Generator to create your own custom skins; just choose your favorite colour or wrap the skin in an imported image. ZDNet’s EasyNoter includes links to ZDNet Downloads and lets you add links of your own.

Web site: http://www.ZDNet.comc
Being an art and a science, photography has its own share of terms and terminologies that can sound like Greek and Latin. But now, there’s no need to be intimidated by the big words in photography. Completing this book is an exhaustive jargon buster that will answer every query you have.
A4 Paper: Standard paper size; 210 x 297mm.

AA Batteries: Digital camera batteries vary by model, from traditional AA size to rechargeables like these:
Nickel Cadmium (NiCad): NiCads have a longer life than traditional batteries but need to be discharged before recharging or they lose their capacity to retain a full charge.
Nickel Metal Hydride (NiMH): NiMHs last longer than NiCads and do not need to be discharged before recharging.
Lithium Ion: Lithium ion batteries hold a charge longer than NiCads or NiMHs.

Accessories: A wide variety of additional pieces of equipment to enhance the productivity of the base equipment.

Adapter: A device used to insert a smaller storage device into a larger slot in a computer or other device.

Additive color system: See RGB.

Adobe Photoshop: A powerful software program from software manufacturer Adobe, which is used to manipulate images. Pictures can be dramatically changed using Photoshop: colours changed, images sharpened, parts of the picture removed or moved, and much more.

Angle of view: The amount of a scene that can be recorded by a particular lens; determined by the focal length of the lens.

Anti-Static Cloth: Prevents the accumulation of static electricity and helps keep the fabric from clinging to other surfaces.

Aperture: The lens opening formed by the iris diaphragm inside the lens. The size of this hole can be made larger or smaller by the autofocus system or a manual control.

Aperture, maximum: The largest size of the hole through which light enters the camera.

Artefacts: A term used to denote unwanted blemishes.
Aspect ratio: The ratio between the width and height of an image or image sensor.

ATA: A standard for storage devices that lets them be treated as if they were hard drives on the system. Any ATA compatible media can be read by any ATA device.

Attachment: A file such as a photography sent along with an e-mail message so it can be viewed or saved at the recipient’s end.

Automatic exposure: A mode of camera operation in which the camera automatically adjusts the aperture, shutter speed, or both for proper exposure.

Automatic flash: An electronic flash unit with a light-sensitive cell that determines the length of the flash for proper exposure by measuring the light reflected back from the subject.

Back-lit: The subject is illuminated from behind and will be underexposed unless you use fill flash or exposure compensation.

Bandwidth: The amount of data that can be sent from one computer to another through a particular connection in a certain amount of time. The more the bandwidth available, the faster you are able to access information.

Battery Life: The maximum period of time that a battery will continue to provide power to the electronic gadget.

Bayer pattern: A pattern of red, green, and blue filters on the image sensor’s photosites. There are twice as many green filters as the other colors because the human eye is more sensitive to green, and therefore green color accuracy is more important.

Bit-mapped: Images formed from pixels with each pixel a shade of gray or color. Using 24-bit colour, each pixel can be set to any one of 16 million colors.
Black and White: Not having or not capable of producing colours; as in “black-and-white film”; “a black-and-white TV”; “the movie was in black and white”.

Blog: A blog is basically a journal available on the Web. The activity of updating a blog is ‘blogging’, and someone who keeps a blog is a ‘blogger’. Blogs are typically updated daily using software that allows people with little or no technical background to update and maintain the blog.

Brightness: A measure of the overall intensity of the image. The lower the brightness value, the darker the image; the higher the value, the lighter the image will be.

Bundled: Characteristic of smaller software programs sold with larger programs or electronics.

Burst mode: The ability of a camera to take one picture after another as long as you hold down the shutter release button.

Camera Angle: The angle defined by the position of the subject matter in relation to the camera lens.

Camera Lens: An optical device made of glass or other transparent material that forms images by bending and focusing rays of light. A lens made of a single piece of glass cannot produce very sharp or exact images, so camera lenses are made up of a number of glass ‘elements’ that cancel out each other’s weaknesses and work together to give a sharp true image. The size, curvature and positioning of the elements determine the focal length and angle of view of a lens.

Camera, Film Camera: A device for taking photographs generally composed of a lightproof enclosure having an aperture with a shuttered lens through which the image of an object is focused and recorded on a photosensitive film or plate.

Card: The sealed package containing storage chips or other devices with electrical connectors that make contact when inserted into a card slot on a camera, printer, computer, or other device.
CCD Image Sensor: A Charge Coupled Device is one of the two main types of image sensors used in digital cameras. When a picture is taken, the CCD is struck by light coming through the camera’s lens. Each of the thousands or millions of tiny pixels that make up the CCD converts this light into electrons. The number of electrons, usually described as the pixel’s accumulated charge, is measured, and then converted to a digital value. This last step occurs outside the CCD, in a camera component called an analogue-to-digital converter.

CCD raw format: The uninterpolated data collected directly from the image sensor before processing.

CD: Compact Disc. A standard medium for storage of digital data in machine-readable form, accessible with a laser-based reader. CDs are 4¾ inches in diameter. CDs are faster and more accurate than magnetic tape for data storage.

CD Burning: Putting data on a CD. The data is burned on with a laser beam in a CD-Writer drive.

Charge-coupled device: An image sensor that reads the charges built up on the sensor’s photosites a row at a time.

Charging A Battery: Energize a battery by passing a current through it in the direction opposite to discharge.

CMOS Image Sensor: An image sensor using CMOS technology. CMOS semiconductors use both NMOS (negative polarity) and PMOS (positive polarity) circuits. Since only one of the circuit types is on at any given time, CMOS chips require less power than chips using just one type of transistor.

Colour balance: The overall accuracy with which the colours in a photograph match or are capable of matching those in the original scene.

Colour depth: The number of bits assigned to each pixel in the image and the number of colours that can be created from those bits. True Colour uses 24 bits per pixel to render 16 million colors.
Colour Correction: Altering colours as they appear in a digital image or in print to ensure that they accurately represent the work depicted.

CompactFlash: A popular form of flash storage for digital cameras.

Composition: The arrangement of objects, elements or forms according to the principles of art.

Compression: The process of reducing the size of a file.

Compression, lossless: A file compression scheme that makes a file smaller without degrading the image.

Compression, lossy: A file compression scheme that reduces the size of a file but degrades it in the process so it can’t be restored to its original quality.

Computer Configuration: This is a general-purpose computer term that can refer to the way you have your computer set up. It is also used to describe the total combination of hardware components that make up a computer system and the software settings that allow various hardware components of a computer system to communicate with each other.

Contrast: The difference between highlights and shadows in a photographic image. The larger the difference in density, the greater the contrast.

Cropping: A method of discarding extraneous material from a digital image.

Depth of field: The distance between the nearest and furthest points that appear in acceptably sharp focus in a photograph. Depth of field varies with lens aperture, focal length, and camera-to-subject distance.

Digital Camera: A camera that does not contain any film, but records
the image as a digital object. The image is usually then downloaded into a computer system.

**Digital Photography:** Photography using a digital camera which stores pictures digitally instead of on film like a traditional camera.

**Digital Zoom:** A digital magnification of the centre 50 per cent of an image. Digital zooms increase the apparent image size by interpolation. They do not increase the amount of image information.

**Docking station:** A small base connected to the computer by a cable. You insert the camera or other device into the docking station to transfer images.

**Download:** To transfer files or data from one computer to another.

**DPI:** Dots Per Inch. A measure of the resolution of a printer, scanner, or monitor. It refers to the number of dots in a one-inch line. The more dots per inch, the higher the resolution.

**Drivers:** A driver is software used to control a hardware component or peripheral device of a computer. If you do not have the current device driver for a specific hardware item (for example, a modem), that device may not function properly.

**Durability:** The ability of the object to withstand the potentially destructive action of natural conditions and chemical reactions.

**DVD:** Digital Versatile Disk is a type of optical media similar to a CD, but can hold 4.7 GB and above in its recordable form.

**E-mail:** Electronic Mail—messages, usually text, sent from one person to another via computer.

**Embed:** To insert an object without maintaining a connection to the
object’s application. Changes in the original object are not reflected when the embedded object is changed.

**Exposure**: The act of exposing film to light in a traditional camera.

**Exposure compensation**: The ability to adjust exposure by one or two stops to lighten or darken the image.

**Exposure/focus lock**: The ability to point at one part of the scene and hold the shutter button halfway down to lock in exposure and focus settings when you point the camera elsewhere to compose the scene.

**Family Tree**: A visual representation of a family that depicts what the relationships between the various family members are.

**Film**: The material used in a camera to record a photographic image. Generally, it is a light-sensitive emulsion coated on a flexible acetate or plastic base.

**Film Photography**: Photography using a traditional camera, which stores pictures on films that require processing and printing.

**Film Processing**: The developing of a camera roll and its subsequent printing as a photograph.

**Flash**: A light source, such as a flashbulb or electronic flash, which emits a very brief, bright burst of light; used in photography as a supplement or alternative to any existing light in a scene.

**Flash card reader**: An accessory that attaches to your computer by cable. You insert a flash memory card into the reader to transfer files.

**Flash memory**: A form of memory using chips instead of magnetic media. The data in the device isn’t lost when the power is turned off.

**Flash memory card**: A card containing chips that store images.
**Flash, fill**: Flash used to fill shadows, even when there is enough light to otherwise take the photograph.

**Flash, ring**: A special circular flash that fits over a lens to take close-up pictures.

**Flash, slave**: A flash that fires when it senses the light from another flash unit.

**FlashPix**: An image format that contains a number of resolutions, each of which is broken into tiles that can be edited and displayed independently.

**Floppy drive**: A storage device on almost all computers that accepts 3½-inch or 5¼-inch floppy disks.

**Focal length**: The distance from the optical centre of the lens to the image sensor when the lens is focused on infinity. The focal length is usually expressed in millimeters and determines the angle of view (how much of the scene can be included in the picture) and the size of objects in the image. The longer the focal length, the narrower the angle of view and the more that objects are magnified.

**Focus**: The process of bringing one plane of the scene into sharp focus on the image sensor.

**Focus lock**: See Exposure/focus lock.

**Frame grabber**: A device that lets you capture individual frames out of a video camera or off a video tape.

**Frame rate**: The number of still pictures in a given period of time.

**Framing**: The photographer’s determination of what the edges of a photograph will be.

**Freeware**: Freeware is software that is available for free with no strings attached. The quality is often superb as the authors are also generally users.
f-stop: A numerical designation (f/2, f 2.8, etc.) indicating the size of the aperture (lens opening).

GIF: An image file format designed for display of line art on the Web.

Grey market: Importing camera equipment outside of the normal manufacturer’s distribution channels to take advantage of lower prices elsewhere in the world.

Greyscale: A series of 256 tones ranging from pure white to pure black.

Grid: A pattern of squares.

Guide number: A rating of a flash’s power.

Hot shoe: A clip on the top of the camera that attaches a flash unit and provides an electrical link to synchronize the flash with the camera shutter.

HTML Page: A page coded in HTML and intended for display on the Web.

IEEE 1394: A port on the computer capable of transferring large amounts of data. Currently the fastest available port.

Image Attributes: Descriptions of the format of an image. Items such as width, height, and bits per pixel are all attributes.

Image sensor: A solid-state device containing a photosite for each pixel in the image. Each photosite records the brightness of the light that strikes it during an exposure.

Inbox: An inbox is a folder that receives new e-mails.

Infrared: See IrDA.

Interface: The on-screen appearance of a computer application or program:
the connection between the user and the program.

Interpolation: In an image, interpolation adds extra pixels. It’s done with some zoom lenses.

Inverse square law: The physical law that causes light from a flash to fall off in such a way that as the flash-to-subject distance doubles, the light falls off by a factor of four.

IrDA: An agreed-upon standard that allows data to be transferred between devices using infrared light instead of cables.

ISO: The speed rating system, maintained by the International Standards Organization (ISO), is most commonly expressed in multiples of 100 (100, 200, 400, 1000), though there are other values available, such as 25 and 50.

JPEG: A very popular digital camera file format that uses lossy compression to reduce file sizes. Developed by the Joint Photographic Experts Group.

Landscape: An expanse of scenery that can be seen in a single view.

Landscape mode: Holding the camera in its normal orientation to make a horizontally-oriented photograph.

Laptop: A portable personal computer.

LCD screen: Digital cameras do not have room for bulky monitors. Instead, they often use an LCD (Liquid Crystal Display) screen which act as a convenient viewfinder for the camera.

Learning Curve: A mathematical relationship used to describe the learning effect.

Lighting: Application of light to a scene, objects or their surroundings so that they may be seen.

Long-focal-length lens (telephoto lens): A lens that provides a narrow angle of view of a scene, including less of a scene than a lens of nor-
mal focal length and therefore magnifying objects in the image.

**LZW Compression**: Lempel-Ziv-Welch; a compression scheme used to reduce the size of image files.

**Macro mode**: A lens mode that allows you to get very close to objects so they appear greatly enlarged in the picture.

**Macro Photography**: This is another way of saying ‘close-up’ photography. Most cameras are unable to focus if the subject is extremely close to the lens; by using a macro lens you can come in much closer.

**Manipulate**: Copy, move, rotate, scale, mirror, or delete an element or group of elements.

**Manual Override**: Operated by hand, and by extension, any non-automatic operation.

**Matrix Metering**: An exposure system that breaks a scene up into a grid and evaluates each section to determine the exposure.

**Megabyte**: A megabyte contains 1,048,576 bytes. In other words, a million bytes is actually less than a megabyte. Abbreviated as MB.

**Megapixel**: Having a resolution of one million pixels. A megapixel digital camera has an image resolution of 1280 x 960 pixels or greater.

**Memory Card**: A card that stores information in an electronic format for digital cameras and small computers.

**Memory Space**: The amount of data a memory card can hold.

**Memory stick**: A flash memory storage device developed by Sony.

**MMS**: Multimedia Messaging Service is a messaging service for the mobile
environment very similar to Short Message Service (SMS), or text messaging. It provides automatic, immediate delivery of personal multimedia messages from phone to phone or from phone to e-mail. In addition to the familiar text content of text messages, multimedia messages can contain images, graphics, voice, and audio clips.

Moore’s Law: Gordon Moore’s law that predicted that the number of transistors on a chip would double every 18 months.

MPEG: Motion Pictures Expert Group; A digital video format developed by the Group.

Multiple exposure: An image made up of two or more images superimposed in the camera.

Multiple exposure mode: A mode that lets you superimpose one image on top of another.

Negatives: The images necessary to reproduce pictures after a film has been processed.

NiCad battery: Nickel-cadmium battery.

NiMH battery: Nickel metal hydride battery. Ecologically safe and very efficient.

Noise: Pixels on the image sensor that misread the light.

Normal-focal-length lens: A lens that provides about the same angle of view of a scene as the human eye and that does not seem to unduly magnify or diminish the size of objects in the image.

NTSC: A US video-out standard to display images on a TV screen.

Open up: To increase the size of the lens aperture. The opposite of stop down.

Operating system: The program that controls the camera’s or computer’s hardware.
Optical viewfinder: See Viewfinder.

Optical Zoom: A zoom lens that uses movement of lens elements to achieve various fields of view. Regardless of whether the zoom is set for wide angle or telephoto viewing, the resolution of the image remains the same.

Orientation sensor: A sensor that knows when you turn the camera to take a vertical shot and rotates the picture so it won't be displayed on its side when you view it.

Overexposure: Exposing the image sensor to more light than is needed to render the scene as the eye sees it. Results in too light a photograph.

PAL: A European video-out standard to display images on a TV screen.

Panorama: A photograph with much wider horizontal coverage than a normal photograph, up to 360 degrees and more.

Panoramic mode: A digital camera mode that uses just the centre band on the image sensor to capture an image that is much wider than it is tall.

Parallax: An effect seen in close-up photography when the viewfinder is offset by some distance from the lens. The scene through the viewfinder is offset from the scene through the lens.

Parallel port: A port on the computer that is faster than a serial port but slower than SCSI, USB, or IEEE 1394 ports. Often used by printers and flash card readers.

PC card: A card, in the case of cameras usually a storage device, that plugs into a slot in a notebook or hand-held computer. Originally called PCMCIA cards.

PCMCIA card: See PC Card.

PDF files: Adobe's Portable Document Format is a translation format
used primarily for distributing files across a network, or on a Web site. Files with a .PDF extension have been created in another application and then translated into .PDF files so they can be viewed by anyone—regardless of platform.

**Perspective:** The appearance to the eye of objects in respect to their relative distance and position; the technique of representing the spatial relationship of objects as they might appear to the eye.

**Photo, Photograph, Snapshot:** A picture of a person or scene in the form of a print or transparent slide or a digital image; recorded by a camera.

**Photoshopping:** Using Adobe Photoshop.

**Photosite:** A small area on the surface of an image sensor that captures the brightness for a single pixel in the image. There is one photosite for every pixel in the image.

**Pixelisation:** An effect seen when you enlarge a digital image too much and the pixels become obvious.

**Pixels:** The small picture elements that make up a digital photograph.

**Pop-Up Box, Pop-Up:** A menu (also known as pull-down or drop-down) that appears in a dialog box or in a main menu when related information is selected.

**Port:** An electrical connection on the computer into which a cable can be plugged so the computer can communicate with another device such as a printer or modem.

**Portrait:** A picture that captures the essence of a person’s appearance and character.

**Portrait mode:** Turning the camera 90 degrees to take a vertically oriented photograph.

**Preview screen:** A small LCD display screen on the back of the camera.
used to compose or look at photographs.

**Printer**: A piece of hardware that prints computer information onto paper.

**Prosumer**: A very serious photographer who can be either an amateur or professional.

**Prosumer**: A prosumer is a pro-active con-somer; culturally and socially aware, building a composite identity of consumer brands and taking an active role in choosing a product or service.

**Rangefinder**: A camera design that has a viewfinder separate from the lens.

**RAW Image**: The RAW image format is the data as it comes directly off the image sensor, with no in-camera processing performed.

**Read out register**: The part of a CCD image sensor that reads the charges built up during an exposure.

**Recycle time**: The time it takes to process and store a captured image.

**Red Eye**: Effect where the pupils of a subject’s eyes appear red in colour photographs taken with certain flash illumination set-ups.

**Red-eye reduction mode**: A mode that fires a preliminary flash to close the iris of the eye before firing the main flash to take the picture.

**Refresh rate**: The time it takes the camera to capture the image after you press the shutter release button.

**Removable media**: Storage media that can be removed from the camera.

**Resolution**: An indication of the sharpness of images on a printout or the display screen. It is based on the number and density of the pixels used. The more pixels used in an image, the more detail can be seen and the higher the image’s resolution.
Resolution, interpolated: A process that enlarges an image by adding extra pixels without actually capturing light from those pixels in the initial exposure.

Resolution, optical: The true resolution of an image based on the number of photosites on the surface of the image sensor.

RGB: The color system used in most digital cameras where red, green, and blue light is captured separately and then combined to create a full colour image.

Scan: The process of using an electronic input device such as a scanner to convert analogue information such as maps, photographs, overlays, etc., into a digital format usable by a computer.

Scanner: An input device that uses light to read printed information and transfers it to the computer in digital format.

SCSI port: A port that’s faster than the serial and parallel ports but slower and harder to configure than the newer USB port. Also known as the Small Computer System Interface.

Sepia: A reddish-brown tone in a photograph.

Serial port: A very slow port on the computer used mainly by modems. Many digital cameras come equipped with a cable to download images through this port, but it’s slow! Both parallel and USB ports are faster connections.

Shareware: Shareware is software you can download, to try before buying. If you do decide to buy it, you’re expected to pay a registration fee.
 Shoot: To depress the shutter release button of the camera to take a photograph.

Short-focal-length lens (wide angle): A lens that provides a wide angle of view of a scene, including more of the subject area than does a lens of normal focal length.

Shutter: A mechanical device on a camera that opens and closes to control the time of a photographic exposure.

Shutter Release: The mechanism, usually a button on the top of the camera, which activates the shutter to expose the film.

Shutter Speed: The length of time the shutter is open and light strikes the image sensor.

Shutter-priority mode: An automatic exposure system in which you set the shutter speed and the camera selects the aperture (f-stop) for correct exposure.

SLR: An SLR or single-lens reflex is really designed for the enthusiast photographer or the person who can put up with a larger camera in return for increased accuracy and greater versatility. This type of camera has through the lens viewing with a mirror behind the lens and a pentaprism to direct the light passing through the lens to the optical finder. The mirror lifts up out of the way as a photograph is taken. As you look through the lens that takes the picture the composition can be more accurate and the lens often removes giving you a wider scope of options. The metering and focusing systems are usually more accurate too.

SmartMedia: A popular form of flash memory card.

Software Package: A computer application program delivered to the user in a complete and ready-to-run form, including all necessary utility programs and documentation.

Spot Metering: Autoexposure based on a meter reading of a small circle in the center of the viewfinder.
Stop1: (a) An aperture setting that indicates the size of the lens opening. (b) A change in exposure by a factor of two. Changing the aperture from one setting to the next doubles or halves the amount of light reaching the image sensor. Changing the shutter speed from one setting to the next does the same thing. Either changes the exposure one stop.

**Stop down:** To decrease the size of the lens aperture. The opposite of open up.

**Studio:** Workplace consisting of a room or building where photographs are shot.

**Subject:** Person or object that’s the centre of the composition.

**Superimposing:** Placing one image on top of another.

**Tagged Image File Format:** See TIFF

**Telephoto lens:** See Long-focal-length lens.

**Thru-the-lens:** See TTL.

**TIFF:** A popular lossless image format used in digital photography.

**Time-lapse photography:** Taking a series of pictures at preset intervals to show such things as flower blossoms opening.

**Tripod:** A three-legged supporting stand used to hold a camera steady.

**TTL:** A camera design that lets you compose an image while looking at the scene through the lens that will take the picture. Also called thru-the-lens.

**Tweak:** Another term for adjustment.

**Unbundling:** When a dealer removes normally included items from a
camera package and then sells them to you separately.

Underexposure: Exposing the film to less light than is needed to render the scene as the eye sees it. Results in a too dark photograph.

Uploading: Sending a file from one’s computer to another computer or device.

URL (Uniform Resource Locator): The address of a Web site.

USB port: A high-speed port that lets you daisy-chain devices (connect one device to another).

VGA: A resolution of 640 x 480.

Video card: A card that fits into a computer’s expansion slot so you can edit digital video.

Viewfinder: A separate window on the camera through which you look to compose images.

Visual Effects: A general term for various photographic manipulations that create illusory spatial relations in the shot, such as superimposition, a matte shot, and rear projection.

Warranty: A guarantee by a seller to a buyer that if a product requires repair or remedy of a problem within a certain period after its purchase, the seller will repair the problem at no cost to the buyer.

Web site: A group of Web Pages that collectively represent a company, or individual on the Internet.

White Balance: Digital cameras have the ability to adjust the colour based on the lighting situation where they are used. This is known as ‘White Balance’. The cameras use white as a reference and adjust the
colour balance to give as true as possible a white, correcting all the other colours by doing this.

**Wide-angle lens**: See Short-focal-length lens.

**Windows XP**: A member of the Microsoft Windows family of operating systems. Windows XP features a new visual design that simplifies navigation and search capabilities, improved file management, additional media and Web publishing capabilities, an improved system for device discovery and installation, and advanced features for mobile computing.

**Zoom**: Expanding an image within the frame by bringing the subject into close-up.

**Zoom lens**: A lens that lets you change focal lengths on the fly.

---

**TIP**

*Using the flash in daylight*: Bright sun can create unattractive deep facial shadows. Eliminate the shadows by using your flash to lighten the face.

When taking people pictures on sunny days, turn your flash on. You may have a choice of fill-flash mode or full-flash mode. If the person is within five feet, use the fill-flash mode; beyond five feet, the full-power mode may be required. With a digital camera, use the picture display panel to review the results. On cloudy days, use the camera’s fill-flash mode. The flash will brighten up people’s faces and make them stand out. Also try taking pictures without the flash—the soft light of overcast days sometimes gives quite pleasing results.